
 
 

Appendix D 
User Guide 

 

 

 



i 

 

Table of Contents 
 

1  DATA SOURCES USED FOR HSRG ANALYSIS ............................................... 1 
1.1  Habitat ................................................................................................................. 1 
1.2  Hatcheries ......................................................................................................... 15 
1.3  Fish passage survival in mainstem .................................................................... 30 
1.4  Harvest .............................................................................................................. 33 

Lower Columbia River Tule Fall Chinook ............................................................... 33 
Lower Columbia River Spring Chinook ................................................................... 34 
Willamette River Spring Chinook ............................................................................ 34 
Middle and Upper Columbia Spring Chinook .......................................................... 34 
Upper Columbia Bright Fall Chinook....................................................................... 34 
Upper Columbia Summer Chinook .......................................................................... 35 
Snake River Bright Fall Chinook .............................................................................. 35 
Snake River Spring/Summer Chinook ...................................................................... 35 
Columbia River Chum .............................................................................................. 36 
Columbia River Coho ............................................................................................... 36 
Snake River Sockeye ................................................................................................ 36 
Wenatchee River Sockeye ........................................................................................ 37 
Columbia River Winter Steelhead ............................................................................ 37 
Lower Columbia River Summer Steelhead .............................................................. 37 
Middle and Upper Columbia River Summer Steelhead ........................................... 37 
Snake River Basin Steelhead .................................................................................... 38 

2  INFORMATION MANAGEMENT ...................................................................... 39 
2.1  Web Site User Guide ........................................................................................ 39 

2.1.1  Background ................................................................................................... 39 
2.1.2  Who may use the hatchery reform website? ................................................. 39 
2.1.3  How to get help with the website .................................................................. 39 
2.1.4  The AHA Tool .............................................................................................. 39 
2.1.5  Data Sets ....................................................................................................... 40 
2.1.6  Step-by-Step Guide to the Hatchery Reform Website Data Tools ............... 41 

2.2  Offline All H Analyzer User Guide .................................................................. 62 
2.2.1  Introduction ................................................................................................... 62 
2.2.2  Before Beginning .......................................................................................... 64 



ii 

 

2.2.3  Application Map ........................................................................................... 65 
2.2.4  Running AHA: A Quick-Start Primer in 5 Easy Steps. ................................ 67 
2.2.5  ADVANCED Features of the AHA Application .......................................... 76 
2.2.6  Ending the AHA Session ............................................................................ 101 

3  REFERENCES .................................................................................................... 106 
 



iii 

 

 

List of Tables 
 
Table 1.  Salmon and steelhead populations by type for the Columbia River Basin used 

in the HSRG analysis for the current condition and HSRG Solution. .......................... 3 

Table 2.  List of assumptions for the HSRG Solution for Elochoman coho. ......................... 4 

Table 3.  Habitat assumptions used in the HSRG analysis of Columbia River populations 
and data sources. .................................................................................................................. 5 

Table 4.  Salmon and steelhead hatchery programs used in the HSRG analysis for the 
current condition and HSRG Solution.  New programs recommended by the HSRG 
are marked in bold. ............................................................................................................ 16 

Table 5.  Salmon and steelhead fish passage assumptions used in the HSRG analysis for 
the current condition and HSRG Solution. .................................................................... 31 

Table 6.  AHA application file types ........................................................................................ 40 

Table 7.  User Defined Population Level Variables ............................................................... 85 



iv 

 

 

List of Figures 
 

Figure 1.  Hatchery Reform Website Home Page. ................................................................. 42 

Figure 2.  Getting Started Wizard. ........................................................................................... 43 

Figure 3.  Select species. ............................................................................................................. 44 

Figure 4.  Select four of six scenarios to download. ............................................................... 45 

Figure 5.  Fully configured 6‐pack. .......................................................................................... 46 

Figure 6.  Click link to download zip file. ............................................................................... 47 

Figure 7.  Global Data Download Wizard. .............................................................................. 48 

Figure 8.  Select global data file to download. ........................................................................ 49 

Figure 9.  Login link. .................................................................................................................. 50 

Figure 10.  Enter username and password. ............................................................................. 50 

Figure 11.  Administrative Tasks links. ................................................................................... 51 

Figure 12.  Select global dataset to upload. ............................................................................. 52 

Figure 13.  Select scenarios to upload. ..................................................................................... 53 

Figure 14.  Error message caused by unsynchronized global dataset IDs. ........................ 54 

Figure 15.  Population Management main page. ................................................................... 56 

Figure 16.  Step 1 of 3, enter required data. ............................................................................ 57 

Figure 17.  Confirm submitted data. ........................................................................................ 58 

Figure 18.  Confirmation page. ................................................................................................. 58 

Figure 19.  Population Modification History page. ............................................................... 59 

Figure 20.  Step 1, rename population. .................................................................................... 60 

Figure 21.  Step 1, rename population. .................................................................................... 60 

Figure 22.  Step 2, confirm edits. .............................................................................................. 61 

Figure 23.  Step 3, confirmation page. ..................................................................................... 61 

Figure 24.  AHA open screen providing version number and contact information. ........ 62 



v 

 

Figure 25.  AHA Landing Page. ................................................................................................ 65 

Figure 26.  AHA application map. ........................................................................................... 66 

Figure 27.  Navigation to the application online web site. ................................................... 67 

Figure 28.  Navigation to File>Open to load data into the offline application. ................. 67 

Figure 29  The file dialog box to load files into the offline application. .............................. 68 

Figure 30.  Locate file dialog box. ............................................................................................. 68 

Figure 31.  Portion of dialog box to locate stray and pattern files. ...................................... 69 

Figure 32.  Completed file dialog box ready to load files. .................................................... 69 

Figure 33.  The AHA offline application with data loaded. ................................................. 70 

Figure 34.  Dropdown menu choices for charts on Welcome/Landing page. .................... 70 

Figure 35.  Filter populations in a dataset. .............................................................................. 71 

Figure 36.  Navigation pathways to the AHA single population view. ............................. 71 

Figure 37.  The single population AHA view. ........................................................................ 72 

Figure 38.  Navigation to the Strays menu item. .................................................................... 72 

Figure 39.  Navigation to the Hatchery Component menu item. ........................................ 73 

Figure 40.  The Hatchery Component screen for a single population. ............................... 73 

Figure 41.  File save options. ..................................................................................................... 74 

Figure 42.  The Windows “Save As” dialog screen to save a *.rol file. ............................... 74 

Figure 43.  Confirmation message to complete the *.rol save. ............................................. 75 

Figure 44.  The Load Files dialog screen with stray matrix and pattern data loaded from 
a previous AHA session.................................................................................................... 75 

Figure 45.  File > Open:  Load Data Files menu ...................................................................... 77 

Figure 46.  Data directory with *.rol file highlighted. ........................................................... 78 

Figure 47.  The AHA Landing Page with population data summary. ................................ 79 

Figure 48.  Dataset reload/add files options. .......................................................................... 80 

Figure 49.  Filtering populations in AHA. .............................................................................. 80 

Figure 50.  Scatter plots filtering options. ............................................................................... 81 



vi 

 

Figure 51.  Main screen and global pattern assumptions. .................................................... 81 

Figure 52.  Scatter plots of population viability and hatchery influence. ........................... 82 

Figure 53.  Dropdown menu options to find a data point of interest in the scatter plots by 
strategy and/or population ............................................................................................... 82 

Figure 54.  Global Pattern settings are shown for six strategies. ......................................... 83 

Figure 55.  Setting global variables for a particular “H” and strategy.  Pre‐defined 
patterns may be selected for all populations by using the drop‐down menu 
associated with each strategy and “H” (Hydro, Harvest, and Habitat). ................... 84 

Figure 56.  The AHA Strategy Builder screen. Model results and edits to population 
inputs can be made through this screen for a specific strategy. .................................. 85 

Figure 57.  Changing the Scenario value for a single population toggles the user‐defined 
strategy feature. .................................................................................................................. 86 

Figure 58.  The Copy Strategy screen. ..................................................................................... 87 

Figure 59.  Renaming a strategy in an AHA dataset. ............................................................ 87 

Figure 60.  Cloning a population in an AHA dataset. ........................................................... 88 

Figure 61.  Confirmation message before deleting a population from the AHA dataset. 89 

Figure 62.  Strategy Page with Chinook dataset loaded. ...................................................... 90 

Figure 63.  Chinook dataset with Stray information shown................................................. 91 

Figure 64.  Navigation pathways to the AHA single population view. ............................. 92 

Figure 65.  The AHA Population screen. This screen shows the inputs and outputs for a 
specific population for all strategies. .............................................................................. 93 

Figure 66.  Navigating to additional input screens for a population. ................................. 94 

Figure 67.  Modifying pattern assignments from the AHA single population screen. .... 97 

Figure 68.  AHA output chart comparing the proportion of hatchery origin fish in the 
naturally spawning component (pHOS) and the proportion of natural origin fish in 
the hatchery broodstock (pNOB).  PNI is the proportionate natural influence in the 
program and is represented by lines through the chart. .............................................. 97 

Figure 69.  Summary of AHA results comparing the number of adult fish in the 
spawning population and in harvest.  The contribution of hatchery origin fish 
(HOS) in each area is shown in pink, and the contribution of natural‐origin fish 
(pNOB) are shown in green. “Candy‐stripe” indicates hatchery fish returning in 



vii 

 

excess to spawning needs while “khaki” indicates return of hatchery‐origin fish 
that have been selected at least one generation in the natural environment. ........... 98 

Figure 70.  Pattern menu items in AHA. ................................................................................. 98 

Figure 71.  Viewer/Editors for Hydro, Harvest, and Habitat patterns. .............................. 99 

Figure 72.  Tabulated data from the population rollup. ..................................................... 100 

Figure 73.  The stray matrix. ................................................................................................... 100 

Figure 74.  Stray reporting by ESU ......................................................................................... 101 

Figure 75.  Options for saving an AHA Rollup dataset. ..................................................... 102 

Figure 76.  Save options for the “Advanced Save” feature. ................................................ 102 

Figure 77.  A request to select a strategy to overwrite and the label for the Strategy under 
the “Advanced Save” option. ......................................................................................... 103 

Figure 78.  The save/export pattern data menu .................................................................... 104 

Figure 79.  Prompt to save AHA Rollup application when closing Excel.  If pattern and 
stray matrix data should be saved in the application, hit OK, then click the function 
key ‐ F12 to save the AHA application as a new file containing pattern data. ....... 105 

 



Columbia River Hatchery Reform Project 
Final Systemwide Report – Appendix D 
User Guide  Page 1 

Appendix D – User Guide 

1 Data sources used for HSRG Analysis 
The HSRG analysis was based on information describing the quality and quantity 
of habitat used by salmon and steelhead populations, fish passage survival 
through the mainstem Snake and Columbia Rivers, hatchery program operations, 
and the harvest of natural and hatchery adults.  The data and information was 
consolidated to form a picture of the Basin’s “current condition”.  This 
information came from reports, analyses by the managers, and conversations with 
knowledgeable individuals.  The HSRG analysis examined a total of 241 natural 
populations in Columbia River Basin (Table 1).  Sixty-eight of these populations 
were integrated with a hatchery release in the current condition.  The analysis 
examined an additional 110 segregated hatchery programs for a total of 351 
populations/programs examined for the current condition.  The HSRG “Solution” 
recommended that 19 segregated programs be eliminated, 10 new segregated 
harvest programs be created, two integrated programs be eliminated, and 24 new 
integrated programs be created for a total of 342 population/ programs examined.  

Sources of information used in the analysis by population or by population group 
are described in the next sections.  Data sources are organized by Habitat (the 
Beverton-Holt survival function parameters for productivity and capacity), 
Hatcheries (broodstock, in-hatchery survival, program recruits per spawner, etc), 
Fish Passage Survival in Mainstem (juvenile and adult passage survival in Snake 
and Columbia rivers), and Harvest (harvest rates on natural and hatchery adults 
in marine, Lower Columbia, Upper Columbia, and terminal fisheries).   

The specific assumptions used in the analysis were entered into the AHA 
spreadsheet application described in more detail in Appendix C.  The use of the 
application is described in Section 2.2 of this appendix.  An example of 
assumptions used and their expected effects on outcome is shown in Table 2.   

1.1 Habitat 
Habitat information comprised population specific estimates of the Beverton-
Holt parameters for productivity (density-independent survival in the 
environment) and capacity (maximum number of individuals that could be 
supported by the habitat). These parameters apply to the complete life cycle and 
include assumptions for juvenile and adult fish passage survival and ocean 
survival.  Productivity and capacity are independent of harvest effects and effects 
of loss due to fitness on the population.  

Habitat data was from a variety of sources and are listed by population in Table 
3. Much of the information was from analyses contained in the Northwest Power 
and Conservation Council’s watershed plans, which were completed in 2005.  
Some information was provided by managers based on a B-H production 
function fit to observed data.  Information for Idaho Chinook populations was 
based on an analysis of tributary habitat potential for salmon described in Budy 
and Schaller (2007), NOAA recovery planning documents for steelhead and 
Chinook, and discussions with managers. In a few cases, productivity and 
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capacity were approximated due to lack of information about a particular 
population.  
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Table 1.  Salmon and steelhead populations by type for the Columbia River Basin used in the HSRG analysis for the current condition and HSRG Solution. 

Evolutionarily Significant Unit 
or population group 

Current Condition HSRG Solution 

No. Natural 
populations 

with integrated 
hatchery 

No. Natural 
Populations 

without 
hatchery 

Total 
Natural 

Populations

No. 
Segregated 
Populations

Total 
Populations

No. Natural 
populations 

with 
integrated 
hatchery 

No. Natural 
Populations 

without 
hatchery 

Total 
Natural 

Populations

No. 
Segregated 
Populations

Total 
Populations

Lower Columbia River Chinook 6 25 31 13 44 13 25 38 13 51
Upper Willamette River Chinook 5 4 9 1 10 7 24 31 15 46
Deschutes River Summer/Fall-
run Chinook 0 1 1 0 1 7 3 10 4 14
Upper Columbia River 
Summer/Fall-run Chinook 6 4 10 7 17 5 5 10 3 13
Middle Columbia River Spring-
run Chinook 5 5 10 2 12 0 1 1 0 1
Upper Columbia River Spring-
run Chinook 4 3 7 2 9 6 1 7 2 9
Snake River Fall-run Chinook 1 0 1 0 1 1 0 1 0 1
Snake River Spring/Summer-run 
Chinook 10 28 38 12 50 5 4 9 1 10
Columbia River Chum 2 15 17 0 17 9 8 17 0 17
Lower Columbia River C  oho 4 25 29 17 46 4 1 5 2 7
Upper Columbia Coho 4 1 5 2 7 7 22 29 15 44
Snake River Soc  keye 1 0 1 0 1 1 0 1 0 1
Wenatchee River Soc  keye 1 0 1 0 1 1 0 1 0 1
Southwest Washington Steelhead 0 7 7 6 13 6 21 27 17 44
Lower Columbia River 
Steelhead 8 13 21 18 39 0 7 7 6 13
Upper Willamette River 
Steelhead 0 5 5 5 10 12 9 21 12 33
Middle Columbia River 
Steelhead 2 15 17 6 23 3 1 4 3 7
Upper Columbia River Steelhead 3 1 4 2 6 3 14 17 3 20
Snake River Basin Steel  head 6 21 27 17 44 0 5 5 5 10

Total All ESUs 68 173 241 110 351 90 151 241 101 342
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Table 2.  List of assumptions for the HSRG Solution for Elochoman coho.  

                    
  Hatchery Program: Elochoman Coho         
  Assumptions                 
  

Habitat based 
Natural 

Production 

Population Designation   Primary       
  Adult Productivity    3.7       
  Adult Capacity   1,315       
  Smolt Productivity   71       
  Smolt Capacity   25,000       
                    

  
Hydro System 

and Marine 
Survival 

Juvenile Passage Survival   1.00       
  Ocean Survival   0.052       
   Adult Passage   1.00        
  Total SAR   0.052       

          Natural Hatchery   
  

Harvest Rates 

Marine   0.100 0.180   
  Lower Mainstem   0.050 0.200   
  Upper Mainstem         
  Terminal   0.020 0.100   
  Total Exploitation Rate    0.162 0.410   
                    

  

Hatchery 
Program 

pNOB-Goal   50%       
  pHOS-Goal   25%       
  Program  Purpose   Harvest       
  Program Type  Integrated       
  Local Broodstock   150       
  Imported Broodstock   0       
  Smolts/Spawner   1,000       
  Smolt Release   146,000       
  % HOR to Hatchery   95%       
  Weir Factor   90%       
  Recruits/Spawner   20.0       
  Fitness Floor   0.5       
  Rel. Reprod. Success   0.8       
            

  Expected Outcome     With Hatchery 
Without 

Hatchery   
  

Long-term 
Average  

NOR Escapement    677 427   
  HOR Escapement    127 117   
                  
  Total Harvest    1,517 83   
                 
  Surplus at Hatchery    1,892     
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Table 3.  Habitat assumptions used in the HSRG analysis of Columbia River populations and data sources.   

Subbasin Population Name 
Population 
Designation  Prod   Capacity Data source 

Lower Columbia River Chinook 

Big Creek Big Creek Fall Chinook (Tules) Stabilizing      3.00           300 No information provided - used rough 
approximation 

Chinook 
River Chinook River Fall Chinook Stabilizing      1.50           100 No information provided - used rough 

approximation 

Clatskanie Clatskanie Fall Chinook Primary    44.00           290 ODFW provided from B-H fit to observed data. 

Columbia 
Gorge 

Gorge Tributaries Fall Chinook 
(Tules- Oregon) Stabilizing      1.50           100 No information provided - used rough 

approximation 

Cowlitz Upper Cowlitz Spring Chinook Primary      2.40        6,530 Tacoma Power Dam relicensing analysis, EDT 
assessment 

Cowlitz Toutle Fall Chinook Stabilizing      3.10        6,748 Columbia River recovery planning, based on EDT 
assessment 

Cowlitz Coweeman  Fall Chinook Primary      4.33        2,376 Columbia River recovery planning, based on EDT 
assessment 

Cowlitz Lower Cowlitz Fall Chinook Contributing      5.90      12,448 Tacoma Power Dam relicensing analysis, EDT 
assessment 

Elochoman Elochoman Fall Chinook Primary      3.80        2,112 Columbia River recovery planning, based on EDT 
assessment 

Grays Grays Fall Chinook Primary      3.70           662 Columbia River recovery planning, based on EDT 
assessment 

Hood Hood Spring Chinook Primary      1.21        1,779 Columbia River recovery planning, based on EDT 
assessment 

Hood Hood Fall Chinook Stabilizing      1.47        4,227 Columbia River recovery planning, based on EDT 
assessment 

Kalama Kalama Spring Chinook Primary      1.76           945 Columbia River recovery planning, based on EDT 
assessment 

Kalama Kalama Fall Chinook Primary      3.90        2,102 Columbia River recovery planning, based on EDT 
assessment 

Lewis EF Lewis Fall Chinook (Tule) Primary      2.84        4,690 Columbia River recovery planning, based on EDT 
assessment 

Lewis NF Lewis Spring Chinook Primary      4.70        2,069 Columbia River recovery planning, based on EDT 
assessment 

Lewis NF Lewis Fall Chinook (Lower 
River Brights) Primary    18.74      21,049 Columbia River recovery planning, based on EDT 

assessment 
Little 
White 
Salmon 

Little White Salmon Fall Chinook 
(Tule) Stabilizing      1.50           500 No information provided - used rough 

approximation 

Lower 
Columbia 

LC Tribs Fall Chinook (Tules-
Oregon) Stabilizing      3.00           300 No information provided - used rough 

approximation 

Mill-Aber-
Germ Mill-Aber-Germ Fall Chinook  Contributing      4.37        1,837 Columbia River recovery planning, based on EDT 

assessment 

Sandy Sandy Spring Chinook Primary      4.80        2,549 City of Portland Water District HCP, EDT 
assessment 

Sandy Sandy Fall Chinook (Late) Primary      5.00        7,097 City of Portland Water District HCP, EDT 
assessment 

Sandy Sandy Fall Chinook (Early) Stabilizing      5.26        7,646 City of Portland Water District HCP, EDT 
assessment 

Scappoose Scappoose Fall Chinook Stabilizing      3.00           300 No information provided - used rough 
approximation 
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Subbasin Population Name 
Population 
Designation  Prod   Capacity Data source 

Washougal Washougal Fall Chinook Primary      3.80        2,378 Columbia River recovery planning, based on EDT 
assessment 

White 
Salmon White Salmon Spring Chinook Contributing      0.00               0 Based on current condition and no fish passage at 

Condit Dam 

White 
Salmon White Salmon Fall Chinook (Tule) Contributing      6.08        1,172 Columbia River recovery planning, based on EDT 

assessment 

Willamette Clackamas Fall Chinook Contributing      1.99           933 Columbia River recovery planning, based on EDT 
assessment 

Wind Wind Spring Chinook Stabilizing      2.88           196 Columbia River recovery planning, based on EDT 
assessment 

Wind Wind Fall Chinook (Tule) Stabilizing      4.54           692 Columbia River recovery planning, based on EDT 
assessment 

Youngs 
Bay Youngs Bay Tribs Fall Chinook Stabilizing      3.00           300 No information provided - used rough 

approximation 

Upper Willamette River Chinook 

Willamette MF Willamette Spring Chinook Contributing      1.10        1,800 ODFW provided from B-H fit to observed data. 

Willamette Molalla Spring Chinook  Stabilizing      1.10           100 ODFW provided from B-H fit to observed data. 

Willamette Calapooia Spring Chinook Stabilizing      1.50           100 No information provided - used rough 
approximation 

Willamette Coast Fork Spring Chinook Stabilizing      1.50           100 No information provided - used rough 
approximation 

Willamette Upper Willamette Fall Chinook 
(Non-Native) N/A      1.50           100 No information provided - used rough 

approximation 

Willamette North Santiam Spring Chinook  Primary      2.00        1,000 ODFW provided from B-H fit to observed data. 

Willamette South Santiam Spring Chinook  Contributing      3.00        2,500 ODFW provided from B-H fit to observed data. 

Willamette Clackamas Spring Chinook Primary      3.62        3,003 Columbia River recovery planning, based on EDT 
assessment 

Willamette McKenzie Spring Chinook  Primary      4.50        8,000 ODFW provided from B-H fit to observed data. 

Deschutes River Summer/Fall-run Chinook 

Deschutes Deschutes Fall Chinook Primary      5.75      29,411 Columbia River recovery planning, based on EDT 
assessment 

Upper Columbia River Summer/Fall-run Chinook 

Entiat Entiat Summer-Fall Chinook (Late 
Run) Stabilizing      1.69           300 Columbia River recovery planning, based on EDT 

assessment 
Mid 
Columbia 
Mainstem 

Hanford Fall Chinook (Priest 
Rapids Upriver Brights) Primary      9.00    150,000 

WDFW provided recent year run size information 
and approximated B-H parameters to be consistent 
with observations 

Klickitat Klickitat Fall Chinook Stabilizing      5.40        5,356 Columbia River recovery planning, based on EDT 
assessment 

Methow Methow Summer Chinook Stabilizing      1.76        1,531 Columbia River recovery planning, based on EDT 
assessment 

Okanogan Okanogan-Similkameen Summer 
Chinook Primary      6.00      10,000 

Colville Tribes provided recent year run size and 
approximated B-H parameters to be consistent 
with observations 

Umatilla Umatilla Fall Chinook Contributing      2.00        6,000 
CTUIR provided recent year run size information 
and approximated B-H parameters to be consistent 
with observations 

Upper 
Columbia 

Upper Middle Columbia Mainstem 
Summer Chinook Stabilizing      5.00        6,000 No information provided - used rough 

approximation 
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Subbasin Population Name 
Population 
Designation  Prod   Capacity Data source 

Mainstem 

Wenatchee Wenatchee Summer Chinook Primary      4.25      13,360 Columbia River recovery planning, based on EDT 
assessment 

Yakima Marion Drain Fall Chinook  Contributing      2.08           448 Columbia River recovery planning, based on EDT 
assessment 

Yakima Yakima Fall Chinook Contributing      3.29      14,989 Columbia River recovery planning, based on EDT 
assessment 

Middle Columbia River Spring-run Chinook 

Deschutes Deschutes Spring Chinook Primary      4.70        1,530 Columbia River recovery planning, based on EDT 
assessment 

John Day MF John Day Spring Chinook Primary      3.50        1,500 Columbia River recovery planning, based on EDT 
assessment 

John Day Upper Mainstem John Day Spring 
Chinook Contributing      4.00        1,500 Columbia River recovery planning, based on EDT 

assessment 

John Day NF John Day Spring Chinook Primary      5.20        3,000 Columbia River recovery planning, based on EDT 
assessment 

Klickitat Klickitat Spring Chinook Primary      6.50        1,271 Columbia River recovery planning, based on EDT 
assessment 

Umatilla Umatilla Spring Chinook Contributing      2.42           942 Columbia River recovery planning, based on EDT 
assessment 

Walla 
Walla Walla Walla Spring Chinook Contributing      4.00           443 Columbia River recovery planning, based on EDT 

assessment 

Yakima Naches Spring Chinook Primary      2.61        2,121 Columbia River recovery planning, based on EDT 
assessment 

Yakima Upper Yakima Spring Chinook Primary      3.28        5,292 Columbia River recovery planning, based on EDT 
assessment 

Yakima American Spring Chinook  Primary      3.89           418 Columbia River recovery planning, based on EDT 
assessment 

Upper Columbia River Spring-run Chinook 

Entiat Entiat Spring Chinook Primary      1.97           344 Columbia River recovery planning, based on EDT 
assessment 

Methow Methow (Methow-Chewuch) Spring 
Chinook Primary      1.92           900 Columbia River recovery planning, based on EDT 

assessment 

Methow Methow (Twisp) Spring Chinook Primary      1.92           240 Columbia River recovery planning, based on EDT 
assessment 

Okanogan Okanogan Spring Chinook Stabilizing      0.90           253 Columbia River recovery planning, based on EDT 
assessment 

Wenatchee Wenatchee (Nason) Spring Chinook Primary      2.78           371 Columbia River recovery planning, based on EDT 
assessment 

Wenatchee Wenatchee (White) Spring Chinook Primary      4.80           253 Columbia River recovery planning, based on EDT 
assessment 

Wenatchee Wenatchee (Chiwawa) Spring 
Chinook Primary      5.04           598 Columbia River recovery planning, based on EDT 

assessment 

Snake River Fall-run Chinook 

Snake 
Hells 
Canyon 

Snake Hells Canyon Fall Chinook Primary      2.95        7,125 

WDFW and NOAA provided recent year run size 
information and approximated B-H parameters to 
be consistent with observations 
 
 

Snake River Spring/Summer-run Chinook 

Asotin Asotin Spring-Summer Chinook Stabilizing      2.30           467 Columbia River recovery planning, based on EDT 
assessment 
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Subbasin Population Name 
Population 
Designation  Prod   Capacity Data source 

Clearwater Lochsa Spring Chinook  Stabilizing      1.30           940 IDFG and NOAA provided approximate B-H 
parameters based on recovery planning analyses 

Clearwater Lower Selway Spring Chinook Contributing      1.30           400 IDFG and NOAA provided approximate B-H 
parameters based on recovery planning analyses. 

Clearwater Upper Selway Spring Chinook Primary      1.30           600 IDFG and NOAA provided approximate B-H 
parameters based on recovery planning analyses. 

Clearwater South Fork Clearwater Spring 
Chinook Stabilizing      1.30        1,875 IDFG and NOAA provided approximate B-H 

parameters based on recovery planning analyses. 

Clearwater South Fork Clearwater_Newsome 
Creek Spring Chinook Contributing      1.30           625 IDFG and NOAA provided approximate B-H 

parameters based on recovery planning analyses. 

Clearwater Lolo Creek Spring Chinook Primary      1.30        1,500 IDFG and NOAA provided approximate B-H 
parameters based on recovery planning analyses. 

Clearwater Lower Clearwater Spring Chinook Stabilizing      1.30           250 IDFG and NOAA provided approximate B-H 
parameters based on recovery planning analyses. 

Grande 
Ronde 

Upper Grande RondeSpring 
Chinook  Stabilizing      1.00           300 

Columbia River recovery planning, EDT 
assessment adjusted following discussions with 
managers 

Grande 
Ronde Catherine Creek Spring Chinook  Primary      2.50           500 

Columbia River recovery planning, EDT 
assessment adjusted following discussions with 
managers 

Grande 
Ronde Lookingglass Creek Spring Chinook Stabilizing      3.00           200 

Columbia River recovery planning, EDT 
assessment adjusted following discussions with 
managers 

Grande 
Ronde Lostine Spring Chinook  Primary      3.65        1,300 

Columbia River recovery planning, EDT 
assessment adjusted following discussions with 
managers 

Imnaha Imnaha Spring-Summer Chinook Primary      4.00        1,500 
ODFW provided recent year run size information 
and approximated B-H parameters to be consistent 
with observations 

Grande 
Ronde Wenaha Spring Chinook  Primary      5.20           488 Columbia River recovery planning, based on EDT 

assessment 

Grande 
Ronde Minam Spring Chinook ) Primary      5.70           338 Columbia River recovery planning, based on EDT 

assessment 

Salmon Camas Creek Spring Chinook  Primary      1.25           750 IDFG and NOAA provided approximate B-H 
parameters based on recovery planning analyses. 

Salmon Loon Creek Spring Chinook  Primary      1.30           800 IDFG and NOAA provided approximate B-H 
parameters based on recovery planning analyses. 

Salmon Marsh Creek Spring Chinook  Primary      1.30           650 IDFG and NOAA provided approximate B-H 
parameters based on recovery planning analyses. 

Salmon Middle Fork_Lower Mainstem 
Spring-Summer Chinook Contributing      1.50           750 IDFG and NOAA provided approximate B-H 

parameters based on recovery planning analyses. 

Salmon Middle Fork_Upper Mainstem 
Spring-Summer Chinook  Primary      1.50        1,000 IDFG and NOAA provided approximate B-H 

parameters based on recovery planning analyses. 

Salmon Big Creek Spring Chinook  Primary      1.60        1,700 IDFG and NOAA provided approximate B-H 
parameters based on recovery planning analyses. 

Salmon Sulphur Creek Spring Chinook  Primary      1.80           360 IDFG and NOAA provided approximate B-H 
parameters based on recovery planning analyses. 

Salmon Chamberlain Creek Spring Chinook Primary      2.00        1,000 IDFG and NOAA provided approximate B-H 
parameters based on recovery planning analyses. 

Salmon Bear Valley Spring Chinook  Primary      2.50        1,400 IDFG and NOAA provided approximate B-H 
parameters based on recovery planning analyses. 

Salmon Little Salmon Spring-Summer 
Chinook Stabilizing      1.30        1,250 IDFG and NOAA provided approximate B-H 

parameters based on recovery planning analyses. 

Salmon EF-SF Johnson Creek Summer 
Chinook Primary      1.45        1,700 IDFG and NOAA provided approximate B-H 

parameters based on recovery planning analyses. 



 

Columbia River Hatchery Reform Project 
Final Systemwide Report – Appendix D 
User Guide  Page 9 

Subbasin Population Name 
Population 
Designation  Prod   Capacity Data source 

 Salmon Secesh Spring Chinook   Primary      1.62        1,350 IDFG and NOAA provided approximate B-H 
parameters based on recovery planning analyses. 

Salmon SF Salmon Summer Chinook Primary      3.00        2,150 IDFG and NOAA provided approximate B-H 
parameters based on recovery planning analyses. 

Tucannon Tucannon Spring Chinook Primary      2.20           550 Columbia River recovery planning, based on EDT 
assessment 

Salmon R Panther Creek Spring Chinook 
(Extirpated) Stabilizing      0.10        1,200 IDFG and NOAA provided approximate B-H 

parameters based on recovery planning analyses. 

Salmon Lemhi River Spring Chinook  Primary      1.31        3,900 IDFG and NOAA provided approximate B-H 
parameters based on recovery planning analyses. 

Salmon Yankee Fork Spring Chinook Stabilizing      1.45           600 IDFG and NOAA provided approximate B-H 
parameters based on recovery planning analyses. 

Salmon East Fork Salmon River Spring-
Summer Chinook  Contributing      1.46        1,500 IDFG and NOAA provided approximate B-H 

parameters based on recovery planning analyses. 

Salmon Lower Salmon Mainstem Spring 
Chinook Contributing      1.50        2,000 IDFG and NOAA provided approximate B-H 

parameters based on recovery planning analyses. 

Salmon Valley Spring Chinook  Contributing      1.55           800 IDFG and NOAA provided approximate B-H 
parameters based on recovery planning analyses. 

Salmon NF Salmon River Spring Chinook  Contributing      1.60           550 IDFG and NOAA provided approximate B-H 
parameters based on recovery planning analyses. 

Salmon Pahsimeroi Summer Chinook   Primary      1.70        3,200 IDFG and NOAA provided approximate B-H 
parameters based on recovery planning analyses. 

Salmon Upper Salmon Mainstem Spring 
Chinook Primary      1.80        2,000 IDFG and NOAA provided approximate B-H 

parameters based on recovery planning analyses. 

Columbia River Chum 
Columbia 
Estuary Big Creek Chum Contributing      1.50           100 No information provided - used rough 

approximation 

Columbia 
Estuary Clatskanie Creek Chum Contributing      1.50           100 No information provided - used rough 

approximation 

Columbia 
Estuary Youngs Bay Tribs Chum  Primary      1.50        1,000 No information provided - used rough 

approximation 

Columbia 
Estuary Mill-Aber-Germ Chum Primary      1.91        1,275 Columbia River recovery planning, based on EDT 

assessment 

Columbia 
Estuary 

Columbia Estuary Tribs Chum (Sea 
Resources) Stabilizing      2.50           450 Columbia River recovery planning, based on EDT 

assessment 

Columbia 
Gorge 

Gorge Tributaries Chum (Lower 
Gorge) Contributing      1.50           100 No information provided - used rough 

approximation 

Columbia 
Gorge 

Gorge Tributaries Chum (Upper 
Gorge) Contributing      1.50           100 No information provided - used rough 

approximation 

Cowlitz Cowlitz Chum  Contributing      1.60        7,038 Columbia River recovery planning, based on EDT 
assessment 

Elochoman Elochoman Chum  Primary      2.00        3,360 Columbia River recovery planning, based on EDT 
assessment 

Grays Grays-Chinook River Chum  Primary      2.50        1,569 Columbia River recovery planning, based on EDT 
assessment 

Kalama Kalama Chum  Contributing      1.50        1,000 No information provided - used rough 
approximation 

Lewis Lewis Chum  Primary      2.50      12,860 Columbia River recovery planning, based on EDT 
assessment 

Lower 
Columbia Salmon Creek Chum  Stabilizing      1.50        1,000 No information provided - used rough 

approximation 

Sandy Sandy Chum  Primary      1.50        1,000 No information provided - used rough 
approximation 
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Subbasin Population Name 
Population 
Designation  Prod   Capacity Data source 

Washougal Washougal Chum  Primary      3.00        2,783 Columbia River recovery planning, based on EDT 
assessment 

Washougal Duncan Creek Chum  Primary      3.70        1,925 Columbia River recovery planning, based on EDT 
assessment 

Willamette Clackamas Chum Contributing      1.50           100 No information provided - used rough 
approximation 

Lower Columbia River Coho 
Columbia 
Estuary Gnat Creek Coho Stabilizing      1.50           100 No information provided - used rough 

approximation 

Columbia 
Estuary Chinook River Coho Stabilizing      3.70           100 Columbia River recovery planning, based on EDT 

assessment 

Columbia 
Estuary Clatskanie Coho (Late-Type N) Stabilizing      4.00           400 No information provided - used rough 

approximation 

Columbia 
Estuary Scappoose Coho Primary      4.00           400 No information provided - used rough 

approximation 

Columbia 
Estuary Youngs Bay Tribs Coho  Stabilizing      4.00           400 No information provided - used rough 

approximation 

Columbia 
Estuary Mill-Aber-Germ Coho (Type N) Contributing      4.71        2,596 Columbia River recovery planning, based on EDT 

assessment 

Columbia 
Estuary Big Creek Coho  Primary      5.00           500 No information provided - used rough 

approximation 

Columbia 
Gorge 

Columbia Gorge Tributaries Coho 
(Oregon) Stabilizing      1.50           100 No information provided - used rough 

approximation 

Columbia 
Gorge 

Columbia Gorge Tributaries Coho 
(WA) Stabilizing      3.20           138 Columbia River recovery planning, based on EDT 

assessment 

Cowlitz Toutle Coho (Early-Type S Natural) Primary      2.17        7,349 Columbia River recovery planning, based on EDT 
assessment 

Cowlitz Coweeman Coho (Type N) Primary      3.37        2,665 Columbia River recovery planning, based on EDT 
assessment 

Cowlitz Lower Cowlitz Coho (Type N) Primary      3.60        5,297 Tacoma Power Dam relicensing analysis, EDT 
assessment 

Cowlitz Cowlitz Upper Cowlitz Coho Stabilizing      6.00      30,000 Tacoma Power Dam relicensing analysis, EDT 
assessment 

Elochoman Elochoman Coho (Late- Type N) Primary      3.70        1,315 Columbia River recovery planning, based on EDT 
assessment 

Fifteenmile Fifteenmile Creek Coho  Stabilizing      1.50           100 No information provided - used rough 
approximation 

Grays Grays Coho (Late-Type N) Primary      3.84        1,623 Columbia River recovery planning, based on EDT 
assessment 

Hood Hood Coho  Contributing      1.50           100 No information provided - used rough 
approximation 

Kalama Kalama Coho (Natural) Contributing      3.79           658 Columbia River recovery planning, based on EDT 
assessment 

Klickitat Klickitat Coho Stabilizing      2.40        1,172 Columbia River recovery planning, based on EDT 
assessment 

Lewis NF Lewis Coho (Early-Type S) Stabilizing      4.70      14,545 Columbia River recovery planning, based on EDT 
assessment 

Lewis NF Lewis Coho (Late-Type N) Contributing      5.20        2,913 Columbia River recovery planning, based on EDT 
assessment 

Lewis EF Lewis Coho Primary      5.28        2,956 Columbia River recovery planning, based on EDT 
assessment 

Sandy Sandy Coho Primary      6.09      13,665 City of Portland Water District HCP, EDT 
assessment 
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Subbasin Population Name 
Population 
Designation  Prod   Capacity Data source 

Washougal Washougal Coho Contributing      2.39        1,584 Columbia River recovery planning, based on EDT 
assessment 

White 
Salmon 

White Salmon Coho (Early- Type 
S)  Contributing      3.70           646 Columbia River recovery planning, based on EDT 

assessment 

Willamette Upper Willamette Tribs coho Stabilizing      1.50           100 No information provided - used rough 
approximation 

Willamette Lower Willamette Tribs Coho Stabilizing      1.64           584 City of Portland watershed planning, EDT 
assessment 

Willamette Lower Clackamas Coho Stabilizing      1.80           704 Columbia River recovery planning, based on EDT 
assessment 

Willamette Upper Clackamas Coho Primary      4.70        2,202 Columbia River recovery planning, based on EDT 
assessment 

Upper Columbia Coho 

Clearwater Clearwater Coho Stabilizing      1.50        1,000 No information provided - used rough 
approximation 

Methow Methow Coho Stabilizing      1.38        1,514 Columbia River recovery planning, based on EDT 
assessment 

Umatilla Umatilla Coho Stabilizing      0.44        1,939 Columbia River recovery planning, based on EDT 
assessment 

Wenatchee Wenatchee Coho Stabilizing      1.49        2,093 Columbia River recovery planning, based on EDT 
assessment 

Yakima Upper Yakima-Naches Coho  Stabilizing      1.80        3,185 Columbia River recovery planning, based on EDT 
assessment 

Snake River Sockeye 
Salmon 
River Redfish Lake Sockeye   Primary      0.14      10,000 Based on IDFG data for egg to smolt and smolt to 

adult survival. 

Wenatchee River Sockeye 

Wenatchee Wenatchee Sockeye  Primary    10.00      15,000 

WDFW provided recent year run size information 
and approximated B-H parameters to be consistent 
with observations 
 

Southwest Washington Steelhead 

Big Creek Big Creek Winter Steelhead (Late) Stabilizing      4.00           100 No information provided - used rough 
approximation 

Clatskanie Clatskanie Winter Steelhead (Late) Stabilizing      4.00           250 ODFW provided from B-H fit to observed data. 

Elochoman Elochoman Winter Steelhead (Late) Contributing      7.49           515 Columbia River recovery planning, based on EDT 
assessment 

Gnat Creek Gnat Creek Winter Steelhead (Late) Stabilizing      4.00             25 ODFW provided from B-H fit to observed data. 

Grays Grays Winter Steelhead (Late) Primary      4.89        1,126 
Columbia River recovery planning, based on EDT 
assessment 
 

Mill-Aber-
Germ 

Mill-Aber-Germ Winter Steelhead 
(Late) Primary      5.06           691 

Columbia River recovery planning, based on EDT 
assessment 
 

Young Bay 
Tribs 

Youngs Bay Tribs Winter Steelhead 
(Late) Stabilizing      3.00           200 ODFW provided from B-H fit to observed data. 

Lower Columbia River Steelhead 
Columbia 
Gorge 

Upper Gorge Tributaries Winter 
Steelhead (Late) Contributing      3.00           250 No information provided - used rough 

approximation 

Coweeman Coweeman Winter Steelhead (Late) Primary      3.34           609 Columbia River recovery planning, based on EDT 
assessment 
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Subbasin Population Name 
Population 
Designation  Prod   Capacity Data source 

Cowlitz Lower Cowlitz Winter Steelhead 
(Late) Contributing      2.80           866 Tacoma Power Dam relicensing analysis, EDT 

assessment 

Cowlitz Upper Cowlitz Winter Steelhead 
(Late) Contributing      3.17        2,657 Tacoma Power Dam relicensing analysis, EDT 

assessment 

Hood Hood Summer Steelhead Primary      2.00           600 Columbia River recovery planning, based on EDT 
assessment 

Hood Hood Winter Steelhead Primary      2.00        2,345 Columbia River recovery planning, based on EDT 
assessment 

Kalama Kalama Winter Steelhead (Late) Primary      3.04           564 Columbia River recovery planning, based on EDT 
assessment 

Kalama Kalama Summer Steelhead Primary      3.23           857 Columbia River recovery planning, based on EDT 
assessment 

Lewis EF Lewis Summer Steelhead Primary      3.00           700 Columbia River recovery planning, based on EDT 
assessment 

Lewis NF Lewis Winter Steelhead (Late) Contributing      3.49           405 Columbia River recovery planning, based on EDT 
assessment 

Lewis EF Lewis Winter Steelhead (Late) Primary      4.37           605 Columbia River recovery planning, based on EDT 
assessment 

Lewis NF Lewis Summer Steelhead Stabilizing      5.30           367 Columbia River recovery planning, based on EDT 
assessment 

Sandy Sandy Winter Steelhead (Late) Primary      3.00        2,500 City of Portland Water District HCP, EDT 
assessment 

Toutle NF Toutle Winter Steelhead (Late) Primary      2.79           963 Columbia River recovery planning, based on EDT 
assessment 

Toutle SF Toutle Winter Steelhead (Late) Primary      3.58        1,038 Columbia River recovery planning, based on EDT 
assessment 

Washougal Salmon Creek Winter Steelhead 
(Late) Stabilizing      2.40             64 Columbia River recovery planning, based on EDT 

assessment 

Washougal Washougal Winter Steelhead (Late) Contributing      3.87           552 Columbia River recovery planning, based on EDT 
assessment 

Washougal Washougal Summer Steelhead Primary      4.27           585 Columbia River recovery planning, based on EDT 
assessment 

Willamette Lower Clackamas Winter Steelhead 
(Late) Primary      3.10        1,134 Columbia River recovery planning, based on EDT 

assessment 

Willamette Upper Clackamas Winter Steelhead 
(Late) Primary    10.10        3,345 Columbia River recovery planning, based on EDT 

assessment 

Wind Wind Summer Steelhead Primary      4.80        1,877 Columbia River recovery planning, based on EDT 
assessment 

Upper Willamette River Steelhead 

Willamette Westside Tribs Winter Steelhead 
(Late) Stabilizing      2.00           250 ODFW provided from B-H fit to observed data. 

Willamette Calapooia Winter Steelhead(Late) Contributing      4.33           756 ODFW provided from B-H fit to observed data. 

Willamette Molalla Winter Steelhead Primary      5.34        1,970 ODFW provided from B-H fit to observed data. 

Willamette North Santiam Winter Steelhead 
(Late) Primary      6.96        3,783 ODFW provided from B-H fit to observed data. 

Willamette South Santiam Winter Steelhead Primary      7.00        3,800 ODFW provided from B-H fit to observed data. 

Middle Columbia River Steelhead 
Big White 
Salmon 

White Salmon Summer-Winter 
Steelhead Stabilizing      3.92             25 Columbia River recovery planning, based on EDT 

assessment 
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Designation  Prod   Capacity Data source 

Deschutes Westside Tributaries Summer 
Steelhead Primary      1.99        1,766 ODFW provided from B-H fit to observed data. 

Deschutes Eastside Tributaries Summer 
Steelhead Primary      4.11        6,055 ODFW provided from B-H fit to observed data. 

Fifteenmile 
Creek Fifteenmile Creek Winter Steelhead Primary      2.23        1,577 Columbia River recovery planning, based on EDT 

assessment 

John Day South Fork Summer Steelhead Contributing      3.27           625 ODFW provided from B-H fit to observed data. 

John Day Upper Mainstem Summer Steelhead Contributing      3.40        1,270 ODFW provided from B-H fit to observed data. 

John Day North Fork Summer Steelhead Primary      3.82        3,925 ODFW provided from B-H fit to observed data. 

John Day Middle Fork Summer Steelhead Primary      3.89        1,712 ODFW provided from B-H fit to observed data. 

John Day Lower Mainstem Summer Steelhead Primary      4.83        4,293 ODFW provided from B-H fit to observed data. 

Klickitat Klickitat Summer-Winter Steelhead Primary      6.26        3,615 Columbia River recovery planning, based on EDT 
assessment 

Walla 
Walla Touchet Summer Steelhead  Primary      1.72           691 Columbia River recovery planning, based on EDT 

assessment 

Umatilla Umatilla Summer Steelhead Primary      1.91        4,230 Columbia River recovery planning, based on EDT 
assessment 

Walla 
Walla Walla Walla Summer Steelhead Primary      1.84        2,180 Columbia River recovery planning, based on EDT 

assessment 

Yakima Upper Yakima Summer Steelhead Contributing      1.32        1,750 Columbia River recovery planning, based on EDT 
assessment 

Yakima Naches Summer Steelhead Primary      1.66        2,056 Columbia River recovery planning, based on EDT 
assessment 

Yakima Toppenish Summer Steelhead  Contributing      3.89        1,082 Columbia River recovery planning, based on EDT 
assessment 

Yakima Satus Summer Steelhead  Primary      4.28        1,247 Columbia River recovery planning, based on EDT 
assessment 

Upper Columbia River Steelhead 

Entiat Entiat Summer Steelhead Primary      0.90           170 Columbia River recovery planning, based on EDT 
assessment 

Methow Methow Summer Steelhead Primary      1.25        1,962 Columbia River recovery planning, based on EDT 
assessment 

Okanogan Okanogan Summer Steelhead Primary      1.65           126 Columbia River recovery planning, based on EDT 
assessment 

Wenatchee Wenatchee Summer Steelhead Primary      2.25           765 Columbia River recovery planning, based on EDT 
assessment 

Snake River Basin Steelhead 

Asotin Asotin Summer Steelhead (A-run) Contributing      2.50        1,400 Columbia River recovery planning, based on EDT 
assessment 

Clearwater SF Clearwater Summer Steelhead 
(B-Run) Stabilizing      1.50           350 IDFG and NOAA provided approximate B-H 

parameters based on recovery planning analyses. 

Clearwater SF Clearwater_Crooked River 
Summer Steelhead (B-Run) Contributing      1.50           400 IDFG and NOAA provided approximate B-H 

parameters based on recovery planning analyses. 

Clearwater Lolo Summer Steelhead (A+B-Run) Contributing      2.00           200 IDFG and NOAA provided approximate B-H 
parameters based on recovery planning analyses. 

Clearwater Lochsa Summer Steelhead (B-Run) Primary      2.50        2,000 IDFG and NOAA provided approximate B-H 
parameters based on recovery planning analyses. 
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Designation  Prod   Capacity Data source 

Clearwater Selway Summer Steelhead (B-Run) Primary      2.50        2,500 IDFG and NOAA provided approximate B-H 
parameters based on recovery planning analyses. 

Clearwater Lower Clearwater Summer 
Steelhead (A-Run) Primary      5.21        1,430 IDFG and NOAA provided approximate B-H 

parameters based on recovery planning analyses. 

Grande 
Ronde 

Upper Grande Ronde Summer 
Steelhead  Primary      1.80        3,665 

Columbia River recovery planning, EDT 
assessment adjusted following discussions with 
managers 

Grande 
Ronde Wallowa Summer Steelhead  Primary      2.89        2,000 

Columbia River recovery planning, EDT 
assessment adjusted following discussions with 
managers 

Grande 
Ronde Joseph Summer Steelhead  Primary      3.00        3,500 

Columbia River recovery planning, EDT 
assessment adjusted following discussions with 
managers 

Grande 
Ronde 

Lower Grande Ronde Summer 
Steelhead Primary      3.90        1,951 

Columbia River recovery planning, EDT 
assessment adjusted following discussions with 
managers 

Imnaha Little Sheep Summer Steelhead Contributing      3.00           200 
ODFW provided recent year run size information 
and approximated B-H parameters to be consistent 
with observations 

Imnaha Imnaha Summer Steelhead Primary      3.00        1,800 
ODFW provided recent year run size information 
and approximated B-H parameters to be consistent 
with observations 

Salmon East Fork Salmon Summer 
Steelhead Primary      1.50        1,048 IDFG and NOAA provided approximate B-H 

parameters based on recovery planning analyses. 

Salmon Upper Salmon Summer Steelhead 
(A-Run) Stabilizing      1.50        1,283 IDFG and NOAA provided approximate B-H 

parameters based on recovery planning analyses. 

Salmon Pahsimeroi Summer Steelhead (A-
Run) Contributing      1.65        1,029 IDFG and NOAA provided approximate B-H 

parameters based on recovery planning analyses. 

Salmon Lemhi Summer Steelhead (A-Run) Primary      1.80        1,139 IDFG and NOAA provided approximate B-H 
parameters based on recovery planning analyses. 

Salmon Panther Creek Summer Steelhead 
(A-Run) Stabilizing      2.00           428 IDFG and NOAA provided approximate B-H 

parameters based on recovery planning analyses. 

Salmon Lower Middle Fork Salmon 
Summer Steelhead (B-Run) Primary      2.50        1,587 IDFG and NOAA provided approximate B-H 

parameters based on recovery planning analyses. 

Salmon Upper Middle Fork Salmon 
Summer Steelhead (B-Run) Primary      2.50        1,667 IDFG and NOAA provided approximate B-H 

parameters based on recovery planning analyses. 

Salmon South Fork Summer Steelhead (B-
Run) Primary      3.00        1,115 IDFG and NOAA provided approximate B-H 

parameters based on recovery planning analyses. 

Salmon Secesh Summer Steelhead (B-Run) Primary      3.00           342 IDFG and NOAA provided approximate B-H 
parameters based on recovery planning analyses. 

Salmon Chamberlain Summer Steelhead (A-
Run) Primary      3.00           399 IDFG and NOAA provided approximate B-H 

parameters based on recovery planning analyses. 

Salmon North Fork Salmon Summer 
Steelhead (A-Run)  Primary      3.00           226 IDFG and NOAA provided approximate B-H 

parameters based on recovery planning analyses. 

Salmon Little Salmon Summer Steelhead 
(A-Run) Stabilizing      3.60           474 IDFG and NOAA provided approximate B-H 

parameters based on recovery planning analyses. 
Snake 
Hells 
Canyon 

Snake Hells Canyon Summer 
Steelhead  Stabilizing      2.00           500 No information provided - used rough 

approximation 

Tucannon Tucannon Summer Steelhead Primary      1.80           275 Columbia River recovery planning, based on EDT 
assessment 
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1.2 Hatcheries 
The HSRG analysis examined 110 segregated1 salmon and steelhead hatchery 
programs for the current condition (Table 1).  As a result of the analysis, the 
HSRG recommended that 19 segregated programs be eliminated, and four new 
segregated harvest programs and six new “stepping stone” programs2 should be 
created.   An additional 68 currently existing integrated programs3 were 
analyzed.  The HSRG recommended eliminating two integrated programs and 
creating an additional 24 integrated programs, some of which were to repl
poorly segregated prog

Hatchery information used in the analysis was from a variety of sources specific 
to each program including Hatchery Genetic Management Plans (HGMP), 
Artificial Production and Evaluation  reports (APRE), Annual Operating Plans 
for fish production programs (AOP), annual M&E reports, hatchery brood year 
data tables, and conversations with hatchery managers.  Some hatchery programs 
had undergone considerable modifications since their HGMP document was 
published.  The analysis in all cases used the most recent information available 
for broodstock source, program size and release strategies.  Survival data for 
hatchery programs (reported as number of recruits per hatchery broodstock 
spawner and post-release survival) were not as current because of the lag in data 
analysis.  The analysis tried to compensate for this lag by asking the managers 
for their perspective on the more recent survival trends.  

Although HGMPs varied in completeness, comprehensive HGMPs included 
information on a wide range of parameters including: 

• Hatchery type (Segregated/Integrated) 

• Broodstock target (number of fish) and hatchery/natural composition in 
the broodstock 

• Broodstock collection procedures  

• Contribution of hatchery fish to natural escapement 

• Proportion of broodstock imported and/or exported 

• Smolt release size and life stage 

• Hatchery survival by life stage 

• Hatchery return rates 

• Hatchery stray rates 

 
Hatchery programs and data sources are listed in Table 4.  Program type, 
purpose, the number of adults used for broodstock, the program release, date of 
the HGMP/APRE report, and agency responsible are shown for each program.   

 
1 A hatchery program was considered to be segregated if the management intent was to create a distinct population 
reproductively isolated from naturally spawning populations. 
2 Stepping stone programs are harvest programs that use broodstock from an integrated program in the same basin. 
3 A hatchery program was considered to be integrated if the management intent was to create a composite 
hatchery/natural population for which the dominant selective pressure was the natural environment. 
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Table 4.  Salmon and steelhead hatchery programs used in the HSRG analysis for the current condition and HSRG Solution.  New programs recommended by the HSRG 
are marked in bold. 

Subbasin Population/Program 
Population 

Designation4 Agency5

Current Condition HSRG Solution 

 HGMP or APRE 
Date  Type6

 Purpose
 Release 
(1,000)  Type Purpose 

 Release 
(1,000)  

Lower Columbia River Chinook 

Big Creek  Big Creek Fall Chinook (Tules-Hatchery) N/A  ODFW  Seg Harv     5,826.6  Seg Harv     5,826.6  October-05

Columbia 
Estuary 

Deep River Spring Chinook (Cowlitz-Merwin-Grays-
Hatchery) N/A  WDFW  Seg Harv        362.3  Seg Harv        362.3  August-04

Columbia 
Gorge Spring Creek Fall Chinook (Tules-Hatchery) Stabilizing  USFWS  Seg Harv   15,044.9  Seg Harv   15,044.9  May-04

Cowlitz Lower Cowlitz Fall Chinook Contributing  WDFW  Int Harv     4,807.4  Int Harv     4,370.4  August-05

Cowlitz Upper Cowlitz Spring Chinook Primary  WDFW  Int Harv     1,263.6  None None              -    August-05

Cowlitz Upper Cowlitz Spring Chinook (Hatchery) N/A  WDFW  NA NA              -    Seg Harv     1,263.6    

Cowlitz Toutle Fall Chinook Stabilizing  WDFW  None None              -    Int Harv     1,561.4  August-04

Cowlitz Toutle Fall Chinook (Hatchery) N/A  WDFW  Seg Harv     2,500.4  NA Harv              -    August-04

Elochoman Elochoman Fall Chinook Primary  WDFW  Int Harv     2,072.1  Int Cons        188.4  August-04

Grays Grays Fall Chinook Primary  WDFW  None None              -    Int Cons          94.2    

Hood Hood Spring Chinook Primary  ODFW  Int Cons        125.9  Int Cons        147.0  June-00

Kalama Kalama Spring Chinook Primary  WDFW  Int Harv        501.3  None None              -    August-04

                                                 
4 Primary, Contributing, and Stabilizing refer to the population designation of the natural population.  Designation does not apply (NA) to segregated hatchery programs.  
5 Agency abbreviations: CTC – Confederated Tribes Colville; CTUIR – Confederated Tribes Umatilla Indian Reservation; CTWS – Confederated Tribes of Warm Springs; IDFG 
– Idaho Fish and Game; NOAA – National Oceans and Atmospheric Administration; NPT – Nez Perce Tribe; ODFW – Oregon Department Fish and Wildlife; USFWS – U.S. 
Fish and Wildlife Service; WDFW – Washington Department Fish and Wildlife; YN – Yakama Nation 
6 Program types are: Integrated (Int), Segregated (Seg), None (natural population that does not have a program under scenario) and Not Applicable (NA – segregated programs 
with no release under scenario). 
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Subbasin Population/Program 
Population 

Designation4 Agency5

Current Condition HSRG Solution 

 HGMP or APRE 
Date  Type6

 Purpose
 Release 
(1,000)  Type Purpose 

 Release 
(1,000)  

Kalama Kalama Spring Chinook (Hatchery) N/A  WDFW  NA Harv              -    Seg Harv        501.3    

Kalama Kalama Fall Chinook (Hatchery) N/A  WDFW  Seg Harv     5,040.0  Seg Harv     5,040.0  August-04

Lewis NF Lewis Spring Chinook (Hatchery) N/A  WDFW  Seg Harv     1,351.4  Seg Harv     1,188.0  August-04

Little White 
Salmon Little White Salmon Fall Chinook (URB-Hatchery) N/A  USFWS  Seg Harv     2,007.2  Seg Harv     2,007.2  May-04

Little White 
Salmon Little White Salmon Spring Chinook (Hatchery) N/A  USFWS  Seg Harv     1,005.2  Seg Harv     1,005.2  May-04

Lower 
Columbia Bonneville Fall Chinook (Hatchery)  N/A  ODFW  Seg Harv     4,493.1  Seg Harv     4,493.1  September-05

Mill-Aber-
Germ Mill-Aber-Germ Fall Chinook (Hatchery) N/A  USFWS  NA Harv              -    Seg Harv     1,023.8    

Sandy Sandy Spring Chinook Primary  ODFW  Int Harv        300.5  Int Harv        300.7  February-06

Washougal Washougal Fall Chinook Primary  WDFW  None None              -    Int Harv     1,123.2    

Washougal Washougal Fall Chinook (Hatchery) N/A  WDFW  Seg Harv     4,002.6  Seg Harv        919.0  August-04

Wind Wind Spring Chinook (Hatchery) N/A  USFWS  Seg Harv     1,145.0  Seg Harv     1,404.4  May-04

Youngs Bay Youngs Bay Fall Chinook (Rogue Brights-CEDC 
SAFE-Hatchery) N/A  ODFW  Seg Harv     1,174.1  Seg Harv     3,342.9  September-05

Youngs Bay Youngs Bay Spring Chinook (CEDC SAFE-Willamette-
Hatchery) N/A  ODFW  Seg Harv        850.1  Seg Harv        850.1  September-05

Upper Willamette River Chinook 

Willamette MF Willamette Spring Chinook Contributing  ODFW  Int Both     1,256.6  Int Both     1,256.6  December-03

Willamette McKenzie Spring Chinook  Primary  ODFW  Int Both     1,265.6  Int Both     1,265.6  November-03

Willamette Molalla Spring Chinook  Stabilizing  ODFW  Int Both          99.1  Int Both          99.1  February-04
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Subbasin Population/Program 
Population 

Designation4 Agency5

Current Condition HSRG Solution 

 HGMP or APRE 
Date  Type6

 Purpose
 Release 
(1,000)  Type Purpose 

 Release 
(1,000)  

Willamette North Santiam Spring Chinook  Primary  ODFW  Int Harv        752.2  Int Harv        752.2  February-04

Willamette South Santiam Spring Chinook  Contributing  ODFW  Int Harv     1,123.2  Int Harv     1,022.3  February-04

Willamette Clackamas Spring Chinook(Hatchery) N/A  ODFW  Seg Harv     1,077.8  Seg Harv     1,077.8  October-04

Upper Columbia River Summer/Fall-run Chinook 

Klickitat Klickitat Fall Chinook (URB-Hatchery) N/A  YN  Seg Harv     3,867.2  Seg Harv     3,436.0  June-05

Methow Methow Summer Chinook (Wells Hatchery) N/A  WDFW  Seg Both        340.8  Seg Both        340.8  August-05

Mid Columbia 
Mainstem 

Columbia Lower Middle Hanford Fall Chinook (Priest 
Rapids Upriver Brights) Primary  WDFW  Int Harv     6,691.2  Int Harv   10,218.5  August-05

Mid Columbia 
Mainstem 

Columbia Lower Middle Columbia Fall Chinook (URB-
Ringold-Hatchery) N/A  WDFW  Seg Harv     3,499.5  NA Harv              -    June-05

Okanogan Okanogan-Similkameen Summer Chinook Primary  WDFW  Int Both        574.1  Int Both        911.2  September-05

Umatilla Umatilla Fall Chinook Contributing 
 
CTUIR/O
DFW  

Int Both        399.2  Int Both        478.9  January-00

Umatilla Umatilla Fall Chinook (Hatchery) N/A 
 
CTUIR/O
DFW  

Seg Harv        648.0  Seg Harv        411.5    

Upper 
Columbia 
Mainstem 

Upper Middle Columbia Mainstem Summer 
Chinook Stabilizing  WDFW  None None              -    Int Both        803.0    

Upper 
Columbia 
Mainstem 

Upper Middle Columbia Summer Chinook (Wells 
Hatchery) N/A  WDFW  Seg Harv        803.0  NA Harv              -    August-05

Upper 
Columbia 
Mainstem 

Mainstem Summer Chinook (Turtle Rock-Hatchery) N/A  WDFW  Seg Harv     1,277.9  Seg Harv        600.4  September-05

Wenatchee Wenatchee Summer Chinook Primary  WDFW  Int Both        737.1  Int Both        737.1  September-05

Yakima Yakima Fall Chinook Contributing  YN  Int Harv        346.6  Int Harv     2,010.1  May-04
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Subbasin Population/Program 
Population 

Designation4 Agency5

Current Condition HSRG Solution 

 HGMP or APRE 
Date  Type6

 Purpose
 Release 
(1,000)  Type Purpose 

 Release 
(1,000)  

Yakima Marion Drain Fall Chinook  Contributing  YN  Int Cons          20.5  Int Cons          20.5  July-05

Yakima Yakima Fall Chinook (Little White Salmon-Hatchery)  N/A  USFWS  Seg Harv     1,701.0  NA Harv              -      

Middle Columbia River Spring-run Chinook 

Deschutes Deschutes Spring Chinook Primary 
 
USFWS/C
TWS  

Int Harv        746.9  Int Harv        746.9  August-04

Deschutes Deschutes Spring Chinook (Round Butte-Hatchery) N/A  ODFW  Seg Harv        320.6  Seg Harv        320.6  March-04

Klickitat Klickitat Spring Chinook Primary  YN  Int Both        831.2  Int Both        800.8  August-04

Mid Columbia 
Mainstem 

Mainstem Columbia Spring Chinook (Ringold Via 
LWS-Hatchery) N/A  WDFW  Seg Harv        487.1  Seg Harv        486.8  May-05

Umatilla Umatilla Spring Chinook Contributing  CTUIR  Int Both        925.2  Int Cons        277.6  May-04

Umatilla Umatilla Spring Chinook (Stepping Stone Hatchery) N/A  CTUIR  NA Harv              -    Seg Harv        562.2    

Walla Walla Walla Walla Spring Chinook Contributing CTUIR/U
SFWS  Int Cons        249.5  Int Cons        198.5  May-05

Yakima Upper Yakima Spring Chinook Primary  YN  Int Both        810.7  Int Both        810.7  July-05

Upper Columbia River Spring-run Chinook 

Methow Methow (Methow-Chewuch) Spring Chinook Primary  WDFW  Int Cons        359.1  Int Cons        359.1  August-05

Methow Methow (Twisp) Spring Chinook Primary  WDFW  Int Cons        183.0  Int Cons        183.0  August-05

Methow Methow Spring Chinook (Winthrop Hatchery) N/A  USFWS  Seg Both        601.5  Seg Both        601.5  August-05

Okanogan Okanogan Spring Chinook Stabilizing  CTC  None None              -    Int Cons          53.9  February-04

Wenatchee Wenatchee (Chiwawa) Spring Chinook Primary  WDFW  Int Cons        351.5  Int Cons        149.1  September-05
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Subbasin Population/Program 
Population 

Designation4 Agency5

Current Condition HSRG Solution 

 HGMP or APRE 
Date  Type6

 Purpose
 Release 
(1,000)  Type Purpose 

 Release 
(1,000)  

Wenatchee Wenatchee (White) Spring Chinook Primary  WDFW  Int Cons          65.9  Int Cons        149.1  September-05

Wenatchee Wenatchee (Nason) Spring Chinook Primary  WDFW  None None              -    Int Cons        149.1  September-05

Wenatchee Wenatchee Spring Chinook (Leavenworth NFH)- 
Hatchery N/A  USFWS  Seg Harv     1,650.2  Seg Harv     1,650.2  August-05

Snake River Fall-run Chinook 
Snake Hells 
Canyon Snake Hells Canyon Fall Chinook Primary WDFW/N

PT  Int Both     5,802.7  Int Both     5,802.7  August-05

Snake River Spring/Summer-run Chinook 

Clearwater Lower Selway Spring Chinook Contributing  NPT  Int Both        429.8  Int Both        429.8  September-02

Clearwater South Fork Clearwater_Newsome Creek Spring 
Chinook Contributing  IDFG  Int Both          75.4  Int Both          75.3  September-02

Clearwater Lolo Creek Spring Chinook Primary  NPT  Int Both        148.8  Int Both          99.7  September-02

Clearwater Lochsa Spring Chinook (Hatchery)  N/A  IDFG  Seg Harv        700.8  Seg Harv        700.8  September-02

Clearwater Lower Selway Spring Chinook (Hatchery) N/A  NPT  Seg Harv        300.3  Seg Harv        300.3  September-02

Clearwater Upper Selway Spring Chinook (Hatchery) N/A  NPT  Seg Harv        300.3  Seg Harv        300.3  September-02

Clearwater South Fork Clearwater Spring Chinook (Hatchery) N/A  IDFG  Seg Harv     1,100.0  Seg Harv     1,100.0  September-02

Clearwater Middle Fork Clearwater Spring Chinook (Kooskia-
Hatchery) N/A  USFWS  Seg Harv        600.7  Seg Harv        600.7  October-02

Clearwater NF Clearwater Spring Chinook (Dworshak-Hatchery) N/A  USFWS  Seg Harv     1,051.1  Seg Harv     1,051.1  September-02

Clearwater Lower Mainstem_Spring Chinook (NPTH-Hatchery) N/A  NPT  Seg Harv        124.6  Seg Harv        124.6    

Grande Ronde Lostine Spring Chinook  Primary ODFW/N
PT  Int Cons        249.5  Int Cons        249.5  December-02

Grande Ronde Catherine Creek Spring Chinook  Primary  ODFW  Int Cons        130.0  Int Cons          75.6  December-02
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Subbasin Population/Program 
Population 

Designation4 Agency5

Current Condition HSRG Solution 

 HGMP or APRE 
Date  Type6

 Purpose
 Release 
(1,000)  Type Purpose 

 Release 
(1,000)  

Grande Ronde Lookingglass Creek Spring Chinook  Stabilizing  ODFW  Int Both        249.5  Int Both        325.1    

Grande Ronde Upper Grande Ronde Spring Chinook  Stabilizing ODFW/C
TUIR  Int Cons        251.0  Int Cons        251.0  December-02

Imnaha Imnaha Spring-Summer Chinook Primary  ODFW  Int Both        359.2  Int Cons        113.4  December-02

Imnaha Imnaha Spring-Summer Chinook (Stepping Stone 
Hatchery) N/A  ODFW  NA Harv              -    Seg Harv        246.2    

Salmon EF-SF Johnson Creek Summer Chinook Primary NPT/IDF
G  Int Both        101.8  Int Both        101.8  November-04

Salmon SF Salmon Summer Chinook Primary  IDFG  None None              -    Int Cons        253.8    

Salmon Pahsimeroi Summer Chinook   Primary  IDFG  None None              -    Int Cons        285.0  November-04

Salmon Upper Salmon Mainstem Spring Chinook Primary  IDFG  None None              -    Int Cons        197.4  September-02

Salmon Little Salmon Spring Chinook (Rapid River-Hatchery) N/A  IDFG  Seg Harv     2,736.6  Seg Harv     2,736.6  November-04

Salmon SF Salmon Summer Chinook  (McCall-Hatchery) N/A  IDFG  Seg Harv     1,060.9  Seg Harv        752.9  September-02

Salmon Pahsimeroi Summer Chinook (Pahsimeroi Hatchery)   N/A  IDFG  Seg Harv        999.4  Seg Harv     1,045.0    

Salmon Upper Salmon Mainstem Spring Chinook (Sawtooth 
Hatchery) N/A  IDFG  Seg Harv     1,034.9  Seg Harv     1,223.0  September-02

Snake Hells 
Canyon Snake Hells Canyon Spring Chinook (Oxbow Hatchery) N/A ODFW/ID

FG  Seg Harv        299.5  Seg Harv        299.5  November-04

Tucannon Tucannon Spring Chinook Primary  WDFW  Int Cons        132.6  Int Cons        163.4  August-05

Columbia River Chum 
Columbia 
Estuary Columbia Estuary_Chum (Sea Resources) Stabilizing  WDFW  None None              -    Int Cons          64.0    

Columbia 
Estuary Mill-Aber-Germ Chum Primary  WDFW  None None              -    Int Cons          61.4    
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Subbasin Population/Program 
Population 

Designation4 Agency5

Current Condition HSRG Solution 

 HGMP or APRE 
Date  Type6

 Purpose
 Release 
(1,000)  Type Purpose 

 Release 
(1,000)  

Columbia 
Estuary Youngs Bay Tribs Chum  Primary  ODFW  None None              -    Int Cons          96.1    

Elochoman Elochoman Chum  Primary  WDFW  None None              -    Int Cons        182.0    

Grays Grays-Chinook River Chum  Primary  WDFW  Int Cons        200.1  Int Cons        115.3  June-04

Lewis Lewis Chum  Primary  WDFW  None None              -    Int Cons        256.4    

Sandy Sandy Chum  Primary  ODFW  None None              -    Int Cons          96.1    

Washougal Duncan Creek Chum  Primary  WDFW  Int Cons          99.9  Int Cons          99.9  August-04

Washougal Washougal Chum  Primary  WDFW  None None              -    Int Cons        217.9    

Lower Columbia River Coho 
Columbia 
Estuary Bernie Creek Coho (Late-Type N-FFA)  N/A  WDFW  Seg Harv          16.5  Seg Harv          16.5  August-04

Columbia 
Estuary Big Creek Coho (Hatchery) N/A  ODFW  Seg Harv        582.1  Seg Harv        582.1  August-05

Columbia 
Estuary Deep River Coho (Early-Type S-Grays-Hatchery) N/A  WDFW  Seg Harv        401.3  Seg Harv        441.0  August-04

Columbia 
Estuary Youngs Bay Coho (Bonneville-Sandy-Hatchery) N/A  ODFW  Seg Harv     1,726.2  Seg Harv     2,701.9  September-05

Cowlitz Cowlitz Upper Cowlitz Coho Contributing  WDFW  Int Harv        238.8  Int Both        501.3  April-05

Cowlitz Lower Cowlitz Coho (Type N) Primary  WDFW  None None              -    Int Harv        850.0  April-05

Cowlitz Toutle Coho (Early-Type S) Primary  WDFW  None None              -    Int Harv        560.3  August-04

Cowlitz Lower Cowlitz Coho (Type N Hatchery) N/A  WDFW  Seg Harv     3,223.4  Seg Harv        840.5  August-04

Cowlitz Toutle Coho (Early-Type S Hatchery) N/A  WDFW  Seg Harv        801.3  NA Harv              -    August-04
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Subbasin Population/Program 
Population 
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Current Condition HSRG Solution 
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Date  Type6

 Purpose
 Release 
(1,000)  Type Purpose 

 Release 
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Elochoman Elochoman Coho (Late- Type N) Primary  WDFW  Int Both        496.1  Int Both        146.5  August-04

Elochoman Elochoman Coho (Early- Type S Hatchery) N/A  WDFW  Seg Harv        415.0  Seg Harv     1,201.1  August-04

Grays Grays Coho (Late-Type N) Primary  WDFW  None None              -    Int Both        155.9    

Grays Grays Coho (Early-Type S-Hatchery) N/A  WDFW  Seg Harv        150.4  NA Harv              -    August-04

Kalama Kalama Coho (Early- Type S) N/A  WDFW  Seg Harv        353.1  Seg Harv        353.1  April-04

Kalama Kalama Coho (Late- Type N) N/A  WDFW  Seg Harv        350.8  Seg Harv        350.8  April-04

Klickitat Klickitat Coho (Lewis-Hatchery) NA  WDFW  Seg Harv     1,238.6  Seg Harv     1,052.3  August-04

Klickitat Klickitat Coho (Washougal-Hatchery) NA  WDFW  Seg Harv     2,461.9  NA Harv              -    August-04

Lewis NF Lewis Coho (Late-Type N) Contributing  WDFW  Int Harv          40.0  Int Cons        231.6  August-04

Lewis NF Lewis Coho (Early-Type S Hatchery) N/A  WDFW  Seg Harv        880.0  Seg Harv        115.8  August-04

Lewis NF Lewis Coho (Late-Type N Hatchery) N/A  WDFW  Seg Harv        815.1  NA Harv              -    August-04

Little White 
Salmon Little White Coho (Hatchery) N/A  USFWS  NA Harv              -    Seg None     1,059.1  May-04

Lower 
Columbia 
River 

Bonneville Coho (Hatchery) N/A  ODFW  Seg Harv     1,247.7  Seg Harv        750.5  September-05

Sandy Sandy Coho (Hatchery) N/A  ODFW  Seg Harv        700.1  Seg None        700.1  August-06

Washougal Washougal Coho Contributing  WDFW  Int Harv        497.9  Int Both        231.6  August-04

Washougal Washougal Coho (Stepping Stone Hatchery) N/A  WDFW  NA Harv              -    Seg Harv        280.2    

Willamette Clackamas-Eagle Creek Coho (Hatchery) NA  USFWS  Seg Harv        349.1  Seg Harv        349.1  May-04
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Upper Columbia Coho 

Clearwater Clearwater Coho Stabilizing USFWS/
NPT  Int Cons        833.9  Int Cons        830.1  May-04

Methow Methow Coho Stabilizing  YN  Int Cons        495.4  Int Cons        495.4  December-99

Umatilla Umatilla Coho (Bonneville-Cascade-Oxbow-Hatchery) NA ODFW/C
TUIR  Seg Harv     1,530.0  Seg Harv     1,530.0  May-06

Wenatchee Wenatchee Coho Stabilizing  YN  Int Cons     1,048.0  Int Cons     1,048.0  May-04

Yakima Upper Yakima-Naches Coho  Stabilizing  YN  Int Both        452.1  Int Both        452.1  May-04

Yakima Yakima Coho (Hatchery) N/A  YN  Seg Both        427.9  Seg Both        427.9  May-04

Snake River Sockeye 

Salmon Redfish Lake Sockeye   Primary IDFG/NO
AA  Int Cons        151.7  Int Cons        750.8  November-04

Wenatchee River Sockeye 

Wenatchee Wenatchee Sockeye  Primary  WDFW  Int Cons        211.7  Int Cons        211.7  August-05

Southwest Washington Steelhead  

Big Creek Big Creek Winter Steelhead (Hatchery) NA  ODFW  Seg Harv          60.0  Seg Harv          60.0  January-05

Elochoman Elochoman Summer Steelhead (Merwin-Hatchery) NA  WDFW  Seg Harv          30.9  Seg Harv          30.9  May-05

Elochoman Elochoman Winter Steelhead (Early-Hatchery) NA  WDFW  Seg Harv          90.7  Seg Harv          90.7  August-04

Gnat Creek Gnat Creek Winter Steelhead (Hatchery) NA  ODFW  Seg Harv          40.0  Seg Harv          40.0  January-05

Grays Grays Winter Steelhead (Early-Elochoman-Hatchery) NA  WDFW  Seg Harv          40.0  Seg Harv          40.0  August-04

Young Bay 
Tribs 

Youngs Bay Tribs Winter Steelhead (Hatchery) 
 
 
 

NA  ODFW  Seg Harv          60.0  Seg Harv          60.0  January-05
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Lower Columbia River Steelhead 

Coweeman Coweeman Winter Steelhead (Early Elochoman-
Hatchery) NA  WDFW  Seg Harv          20.2  Seg None          20.2  August-04

Cowlitz Lower Cowlitz Winter Steelhead (Late) Contributing  WDFW  Int Both        288.7  Int Both        288.7  August-05

Cowlitz Upper Cowlitz Winter Steelhead (Late) Contributing  WDFW  Int Both        199.1  Int Both          99.3  August-05

Cowlitz Lower Cowlitz Summer Steelhead (Skamania-Hatchery) NA  WDFW  Seg Harv        549.2  Seg Harv        549.2  August-05

Cowlitz Lower Cowlitz Winter Steelhead (Early-Hatchery) NA  WDFW  Seg Harv        302.4  Seg Harv        302.4  August-05

Hood Hood Summer Steelhead Primary  ODFW  Int Cons          31.4  Int Cons          31.4  June-00

Hood Hood Winter Steelhead Primary  ODFW  Int Cons          49.2  Int Cons          49.2  July-00

Hood Hood Summer Steelhead (Santiam-Hatchery) NA  ODFW  Seg Harv          31.5  NA Harv              -    July-00

Kalama Kalama Summer Steelhead Primary  WDFW  Int Cons          30.5  Int Cons          86.7  April-04

Kalama Kalama Winter Steelhead (Late) Primary  WDFW  Int Harv          45.2  Int Harv          99.7  August-04

Kalama Kalama Summer Steelhead (Skamania-Hatchery) NA  WDFW  Seg Harv          30.7  NA Harv              -    April-04

Kalama Kalama Winter Steelhead (Early-Hatchery) NA  WDFW  Seg Harv          45.8  NA Harv              -    August-04

Lewis EF Lewis Summer Steelhead Primary  WDFW  None None              -    Int Harv          40.7  August-04

Lewis EF Lewis Winter Steelhead (Late) Primary  WDFW  None None              -    Int Both          40.3  August-04

Lewis EF Lewis Summer Steelhead (Skamania-Hatchery) NA  WDFW  Seg Harv          24.7  NA Harv              -    August-04

Lewis EF Lewis Winter Steelhead (Skamania-Hatchery) NA  WDFW  Seg Harv          90.7  NA Harv              -    August-04
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Subbasin Population/Program 
Population 

Designation4 Agency5

Current Condition HSRG Solution 

 HGMP or APRE 
Date  Type6

 Purpose
 Release 
(1,000)  Type Purpose 

 Release 
(1,000)  

Lewis NF Lewis Summer Steelhead (Merwin-Hatchery) NA  WDFW  Seg Harv        284.8  Seg Harv        284.8  August-04

Lewis NF Lewis Winter Steelhead (Merwin-Hatchery) NA  WDFW  Seg Harv        100.2  Seg Harv        100.2  August-04

Sandy Sandy Winter Steelhead (Late) Primary  ODFW  Int Harv        159.9  Int Harv        159.9  March-02

Sandy Sandy Summer Steelhead (South Santiam-Hatchery) NA  ODFW  Seg Harv          75.0  Seg Harv          75.0  July-06

Toutle NF Toutle Winter Steelhead (Late) Primary  WDFW  None None              -    Int Harv        142.2    

Toutle NF Toutle Summer Steelhead (Hatchery) NA  WDFW  Seg Harv          24.7  NA Harv              -    April-04

Toutle SF Toutle Summer Steelhead (Hatchery) NA  WDFW  Seg Harv          24.7  Seg Harv          23.9  May-05

Washougal Washougal Summer Steelhead Primary  WDFW  None None              -    Int Harv        100.4    

Washougal Salmon Creek Winter Steelhead (Skamania-Hatchery) NA  WDFW  Seg Harv          24.7  Seg Harv          24.7  August-04

Washougal Washougal Summer Steelhead (Skamania-Hatchery) NA  WDFW  Seg Harv          60.3  Seg Harv          28.7  August-04

Washougal Washougal Winter Steelhead (Early-Skamania-
Hatchery) NA  WDFW  Seg Harv          59.4  Seg Harv          63.0  August-04

Willamette Lower Clackamas Winter Steelhead (Late) Primary  ODFW  Int Harv        164.9  Int Harv          80.4  October-01

Willamette Clackamas Summer Steelhead (Hatchery) NA  ODFW  Seg Harv        174.8  Seg Harv        174.8  June-06

Willamette Clackamas-Eagle Creek Winter Steelhead (Early-
Hatchery) NA  USFWS  Seg Harv        151.0  Seg Harv        151.0  May-04

Upper Willamette River Steelhead 

Willamette MF Willamette Summer Steelhead (S.Santiam-
Hatchery) NA  ODFW  Seg Harv        114.5  Seg Harv        114.5  October-04

Willamette Mainstem Willamette Summer Steelhead (S.Santiam-
Hatchery) NA  ODFW  Seg Harv          51.2  Seg Harv          51.2  October-04
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Subbasin Population/Program 
Population 

Designation4 Agency5

Current Condition HSRG Solution 

 HGMP or APRE 
Date  Type6

 Purpose
 Release 
(1,000)  Type Purpose 

 Release 
(1,000)  

Willamette McKenzie Summer Steelhead (S.Santiam-Hatchery) NA  ODFW  Seg Harv        123.5  Seg Harv        123.5  October-04

Willamette North Santiam Summer Steelhead (S. Santiam Hatchery) NA  ODFW  Seg Harv        161.1  Seg Harv        161.1  October-04

Willamette South Santiam Summer Steelhead (Hatchery) NA  ODFW  Seg Harv        144.1  Seg Harv        144.1  October-04

Middle Columbia River Steelhead 
Big White 
Salmon White Salmon Summer Steelhead (Skamania-Hatchery) NA  WDFW  Seg Harv          20.1  NA Harv              -    August-04

Big White 
Salmon White Salmon Winter Steelhead (Skamania-Hatchery) NA  WDFW  Seg Harv          19.8  NA Harv              -    August-04

Deschutes Deschutes Summer Steelhead (Round Butte-Hatchery) NA  ODFW  Seg Harv        162.1  Seg None        162.1  March-04

Klickitat Klickitat Summer-Winter Steelhead Primary  YN  None None              -    Int Both        120.4    

Klickitat Klickitat Summer Steelhead (Skamania-Hatchery) NA  WDFW  Seg Harv        100.5  NA Harv              -    August-04

Umatilla Umatilla Summer Steelhead Primary CTUIR/O
DFW  Int Both        149.9  Int Harv        149.9  July-05

Walla Walla Touchet Summer Steelhead  Primary  WDFW  Int Cons          49.2  Int Cons          49.2  July-05

Walla Walla Walla Walla Summer Steelhead (Lyons Ferry-Hatchery) NA  WDFW  Seg Harv        100.2  Seg Harv        100.2  July-05

Walla Walla Touchet Summer Steelhead (Lyons Ferry-Hatchery) NA  WDFW  Seg Harv          84.4  Seg Harv          21.1  July-05

Upper Columbia River Steelhead 

Methow Methow Summer Steelhead Primary  USFW  Int Both        420.1  Int Both        100.2  August-05

Methow Methow Summer Steelhead (Stepping Stone 
Hatchery) NA  USFW  NA Harv              -    Seg Harv        319.8    

Mid Columbia 
Mainstem 

Middle Columbia Mainstem_Ringold Summer Steelhead 
(Wells Hatchery) NA  WDFW  Seg Harv        171.1  Seg Harv        171.1  May-05

Okanogan Okanogan Summer Steelhead Primary CCT/WD
FW  Int Cons          20.0  Int Both        199.9  August-05
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Subbasin Population/Program 
Population 

Designation4 Agency5

Current Condition HSRG Solution 

 HGMP or APRE 
Date  Type6

 Purpose
 Release 
(1,000)  Type Purpose 

 Release 
(1,000)  

Okanogan Okanogan Summer Steelhead (Wells-Hatchery) NA  WDFW  Seg Harv        138.9  NA Harv              -      

Wenatchee Wenatchee Summer Steelhead Primary  WDFW  Int Both        401.0  Int Both        100.1  August-05

Wenatchee Wenatchee Summer Steelhead (Stepping Stone 
Hatchery) NA  WDFW  NA Harv              -    Seg Harv        300.7    

Snake River Basin Steelhead 

Clearwater SF Clearwater Summer Steelhead (B-Run) Stabilizing  USFWS  Int Harv        399.8  Int Harv        248.3  September-02

Clearwater SF Clearwater_Crooked River Summer Steelhead (B-
Run) Contributing  USFWS  Int Harv          84.2  Int Harv        123.9  September-02

Clearwater Lolo Summer Steelhead (A+B-Run) Contributing  IDFG  Int Cons          49.7  Int Cons          49.4    

Clearwater SF Clearwater Summer Steelhead (B-Run Hatchery) N/A  IDFG  Seg Harv        911.3  Seg Harv        911.3    

Clearwater NF Clearwater Summer Steelhead (B-Run-Hatchery) N/A  IDFG  Seg Harv     1,199.3  Seg Harv     1,199.3    

Clearwater Lower Clearwater Summer Steelhead (B-Run-Hatchery) N/A  IDFG  Seg Harv        298.0  Seg Harv        298.0  September-02

Grande Ronde Wallowa Summer Steelhead (Hatchery)  NA  ODFW  Seg Harv        799.3  Seg Harv        799.3  September-02

Grande Ronde Cottonwood Creek Summer Steelhead (Wallowa-Lyons 
Ferry-Hatchery) NA  WDFW  Seg Harv        160.1  Seg Harv        160.1  July-05

Imnaha Little Sheep Summer Steelhead Contributing  ODFW  Int Both        212.3  Int Both          87.7  May-02

Imnaha Little Sheep Summer Steelhead (Stepping Stone 
Hatchery) NA  ODFW  NA Harv              -    Seg Harv        126.3    

Lower Snake Snake Lower Summer Steelhead (Lyons Ferry-
Hatchery) NA  WDFW  Seg Harv          60.6  Seg Harv          60.6  July-05

Salmon East Fork Salmon Summer Steelhead Primary  IDFG  Int Cons          49.5  Int Cons        100.1  September-02

Salmon Little Salmon Summer Steelhead (A-Run-Pahsimeroi-
Oxbow-Hatchery) N/A  IDFG  Seg Harv        645.0  Seg Harv        645.0  September-02
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Subbasin Population/Program 
Population 

Designation4 Agency5

Current Condition HSRG Solution 

 HGMP or APRE 
Date  Type6

 Purpose
 Release 
(1,000)  Type Purpose 

 Release 
(1,000)  

Salmon Little Salmon Summer Steelhead (B-Run-Dworshak-
Hatchery) N/A IDFG/US

FWS  Seg Harv        316.3  Seg Harv        316.3    

Salmon Lemhi Summer Steelhead (A-Run-Pahsimeroi Hatchery) N/A  IDFG  Seg Harv        119.7  Seg Harv        119.7  September-02

Salmon Pahsimeroi Summer Steelhead (A-Run-Pahsimeroi-
Hatchery) N/A  IDFG  Seg Harv     1,086.8  Seg Harv     1,081.3  September-02

Salmon East Fork Salmon Summer Steelhead (B-Run 
Dworshak-Hatchery) N/A 

 
IDFG/US
FWS  

Seg Harv        324.8  Seg Harv        324.8  September-02

Salmon East Fork Salmon Summer Steelhead (A-Run 
Pahsimeroi-Hatchery) N/A  IDFG  Seg Harv        180.5  Seg Harv        180.5  September-02

Salmon Upper Salmon Summer Steelhead (A-Run Sawtooth-
Pahsimeroi-Hatchery) N/A  IDFG  Seg Harv     1,284.6  Seg Harv     1,284.6  September-02

Salmon Upper Salmon Summer Steelhead (B-Run Dworshak-
Hatchery) N/A 

 
IDFG/US
FWS  

Seg Harv        250.3  Seg Harv        250.3  September-02

Salmon Upper Salmon Summer Steelhead (Upper Salmon B-
Run-Hatchery) N/A  IDFG  Seg Harv          59.2  Seg Harv        134.6  September-02

Snake Hells 
Canyon 

Snake Hells Canyon Summer Steelhead (Oxbow-
Hatchery) NA ODFW/ID

FG  Seg Harv        525.4  Seg Harv        525.4  November-04

Tucannon Tucannon Summer Steelhead Primary  WDFW  Int Cons          50.9  Int Cons          50.9  July-05

Tucannon Tucannon Summer Steelhead (Lyons Ferry-Hatchery) NA  WDFW  Seg Harv        100.7  NA Harv              -    July-05
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1.3 Fish passage survival in mainstem 
Fish passage survival information comprised of subbasin and species/run specific 
estimates of survival rates of juveniles and adults through the Snake and 
Columbia rivers hydroelectric system.  Passage survival used in the analysis is 
from juveniles entering the mainstem of the Columbia or Snake rivers to the 
Bonneville Dam tailrace and from adults passing Bonneville Dam to adults 
entering the subbasin.  The HSRG analysis for the current condition used 
information provided by the managers and from analyses developed for the 2008 
Federal Columbia River Power System biological opinion (NMFS 2008).  The 
HSRG Solution included improvements in juvenile fish passage survival 
predicted by computer simulation using the COMPASS model and summarized 
in the 2008 FCRPS Biological Opinion (NMFS 2008).  Juvenile survival 
assumptions included in-river and transported migration routes and appropriate 
delayed affects of transported juveniles.  Results from the COMPASS model 
were not available for all ESUs or life history types.  In these cases either the 
analysis made no assumptions for improved survival or the analysis 
approximated possible improvements in juvenile fish passage survival by 
multiplying the relative adjustment reported from the COMPASS model for a 
similar population group.  For example, NMFS (2008) made no predictions for 
Snake River Fall Chinook, however, the HSRG analysis thought a 5 percent 
multiplier on juvenile passage survival was reasonable to evaluate if improved 
fish passage survival affected recommendations for this population.  
Improvements in fish passage survival for Upper Columbia summer Chinook 
were based on predicted improvements reported for Upper Columbia spring 
Chinook.  Compass simulation runs were completed for Snake River steelhead 
and predict no effect on fish passage survival.  

Fish passage survival rates used in the HSRG analysis for populations upstream 
of Bonneville Dam are listed in Table 5.   
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Table 5.  Salmon and steelhead fish passage assumptions used in the HSRG analysis for the current condition 
and HSRG Solution.  

Subbasin 
Number 

Dams 

 Current  HSRG Solution 
 Out-

migration 
Survival 

 Adult 
Upstream 
Survival 

 Out-
migration 
Survival 

 Adult 
Upstream 
Survival  

 Smolt-
Adult 

adjustment 
Lower Columbia River Chinook 
Columbia Gorge (Upper) 1          0.85           0.98         0.85         0.98           1.00  
Hood - Fall run 1          0.85           0.98         0.85         0.98           1.00  
Hood - Spring run 1          0.95           0.98         0.95         0.98           1.00  
Little White Salmon - Fall run 1          0.85           0.98         0.85         0.98           1.00  
Little White Salmon - Spring run 1          0.95           0.98         0.95         0.98           1.00  
White Salmon - Fall run 1          0.85           0.98         0.85         0.98           1.00  
White Salmon - Spring run 1          0.95           0.98         0.95         0.98           1.00  
Wind - Fall run 1          0.85           0.98         0.85         0.98           1.00  
Wind - Spring run 1          0.95           0.98         0.95         0.98           1.00  
Deschutes River Summer/Fall-run Chinook  
Deschutes 2          0.72           0.96         0.72         0.94           1.00  
Upper Columbia River Summer/Fall-run Chinook  
Klickitat 1          0.85           0.98         0.84         0.97           1.00  
Umatilla 3          0.61           0.89         0.61         0.89           1.00  
Mid-Columbia Mainstem 4          0.52           0.91         0.52         0.91           1.00  
Yakima 4          0.52           0.91         0.52         0.91           1.00  
Wenatchee 7          0.37           0.87         0.40         0.87           1.09  
Entiat 8          0.32           0.85         0.35         0.85           1.10  
Upper Columbia Mainstem 8          0.32           0.85         0.35         0.85           1.10  
Methow 9          0.27           0.83         0.30         0.83           1.10  
Okanogan 9          0.27           0.83         0.30         0.83           1.10  
Middle Columbia River Spring-run Chinook 
Klickitat 1          0.95           0.98         0.95         0.98           1.00  
Deschutes 2          0.82           0.96         0.82         0.96           1.00  
John Day 3          0.74           0.94         0.74         0.94           1.00  
Umatilla 3          0.74           0.92         0.74         0.92           1.00  
Mid-Columbia Mainstem 4          0.67           0.87         0.67         0.87           1.00  
Walla Walla 4          0.67           0.90         0.67         0.90           1.00  
Yakima 4          0.67           0.87         0.67         0.87           1.00  
Upper Columbia River Spring-run Chinook 
Wenatchee 7          0.55           0.87         0.60         0.87           1.09  
Entiat 8          0.51           0.85         0.56         0.85           1.10  
Methow 9          0.49           0.83         0.53         0.83           1.10  
Okanogan 9          0.49           0.83         0.53         0.83           1.10  
Snake River Fall-run Chinook  
Snake Hells Canyon 8          0.27           0.78         0.28         0.78           1.05  
Snake River Spring/Summer-run Chinook  
Tucannon 6          0.44           0.86         0.45         0.86           1.05  
Asotin 8          0.34           0.82         0.35         0.82           1.05  
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Subbasin 
Number 

Dams 

 Current  HSRG Solution 
 Out-

migration 
Survival 

 Adult 
Upstream 
Survival 

 Out-
migration 
Survival 

 Adult 
Upstream 
Survival  

 Smolt-
Adult 

adjustment 
Clearwater 8          0.34           0.82         0.35         0.82           1.05  
Grande Ronde 8          0.34           0.82         0.35         0.82           1.05  
Imnaha 8          0.34           0.82         0.35         0.82           1.05  
Salmon 8          0.34           0.82         0.35         0.82           1.05  
Snake Hells Canyon 8          0.34           0.82         0.35         0.82           1.05  
Columbia River Chum  
Columbia Gorge (Upper) 1          0.85           0.97         0.85         0.97           1.00  
Lower Columbia River Coho 
Columbia Upper Gorge Tributaries 1          0.90           0.90         0.97         0.90           1.00  
Fifteenmile Creek 1          0.90           0.97         0.82         0.97           1.00  
Hood 1          0.90           0.97         0.82         0.97           1.00  
Klickitat 1          0.90           0.97         0.90         0.97           1.00  
Little White Salmon 1          0.90           0.97         0.97         0.97           1.00  
White Salmon 1          0.90           0.97         0.90         0.97           1.00  
Upper Columbia Coho  
Umatilla 3          0.74           0.92         0.74         0.92           1.00  
Yakima 4          0.67           0.92         0.67         0.92           1.00  
Wenatchee 7          0.55           0.87         0.60         0.87           1.09  
Methow 9          0.49           0.83         0. 54        0.83           1.10  
Clearwater 8          0.52           0.85         0.55         0.85           1.05  
Snake River Sockeye  
Salmon 8          0.34           0.54         0.36         0.54           1.05  
Wenatchee River Sockeye  
Wenatchee 7          0.41           0.73         0.44         0.73           1.09  
Lower Columbia River Steelhead 
Columbia Upper Gorge Tributaries 1          0.97           0.97         0.97         0.97           1.00  
Hood 1          0.97           0.97         0.97         0.97           1.00  
Wind 1          0.97           0.97         0.97         0.97           1.00  
Middle Columbia River Steelhead 
Fifteenmile Creek 1          0.97           0.97            0.97        0.97           1.00  
Klickitat 1          0.97           0.97            0.97        0.97           1.00  
White Salmon 1          0.97           0.97            0.97        0.97           1.00  
Deschutes 2          0.72           0.97            0.76        0.97           1.05  
John Day 3          0.70           0.91            0.76        0.91           1.08  
Umatilla 3          0.70           0.94            0.76        0.94           1.08  
Walla Walla 4          0.47           0.89            0.52        0.89           1.10  
Yakima 4          0.47           0.91            0.52        0.91           1.10  
Upper Columbia River Steelhead 
Wenatchee 7          0.35           0.87         0.43         0.87           1.23  
Entiat 8          0.33           0.85         0.41         0.85           1.23  
Methow 9          0.32           0.83         0.40         0.83           1.23  
Okanogan 9          0.32           0.83         0.40         0.83           1.23  
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Subbasin 
Number 

Dams 

 Current  HSRG Solution 
 Out-

migration 
Survival 

 Adult 
Upstream 
Survival 

 Out-
migration 
Survival 

 Adult 
Upstream 
Survival  

 Smolt-
Adult 

adjustment 
Snake River Basin Steelhead 
Tucannon 6          0.59           0.89         0.59         0.89           1.00  
Asotin 8          0.49           0.83         0.49         0.83           1.00  
Clearwater - A-Run 8          0.49           0.77         0.49         0.77           1.00  
Clearwater - B-Run 8          0.49           0.77         0.49         0.77           1.00  
Grande Ronde 8          0.49           0.78         0.49         0.78           1.00  
Imnaha 8          0.49           0.89         0.49         0.89           1.00  
Salmon - A-Run 8          0.49           0.77         0.49         0.77           1.00  
Salmon - B-Run 8          0.49           0.77         0.49         0.77           1.00  
Snake Hells Canyon 8          0.49           0.77         0.49         0.77           1.00  
 
 

1.4 Harvest 
Harvest information used in the analysis was the estimated harvest rates for four 
major fisheries (defined by harvest area7) for natural-origin and hatchery-origin 
adults.  Mark-selective fisheries were the difference in harvest rates between 
natural and hatchery-origin fish. 

Harvest rates were based on major stock groups with the exception of terminal 
areas, which were population specific.  Data sources for harvest were from 
annual reports produced by the Joint Columbia River Management Staff of the 
Oregon Department of Fish and Wildlife (ODFW) and Washington Department 
of Fish and Wildlife (WDFW), NOAA biological opinions describing maximum 
allowable harvest impacts, state guidelines, and US v. Oregon agreements.  The 
analysis used average run size to determine harvest rates for stock groups that 
were abundance driven.  Managers also may have provided population specific 
harvest rates based on an analysis of coded-wire tags recovered in fisheries.  

Harvest rates used in the analysis are summarized in the following sections by 
major harvest group.  Each section begins with an overview of rates and sources 
of information for the current condition and is followed by a description of 
harvest rates that were used for the HSRG Solution. 

Lower Columbia River Tule Fall Chinook  
The impact rate limit on lower Columbia River Tule fall Chinook has varied in 
recent years.  The analysis was based on the recent year average combined 
harvest impact of approximately 50 percent.  Most of the harvest is in the ocean 
and lower Columbia River mainstem.  Terminal rates varied from 0 – 25 percent 

                                                 
7 Harvest areas in the analysis are: marine, lower Columbia River mainstem downstream of Bonneville 
Dam, upper Columbia River mainstem upstream of Bonneville Dam to McNary Dam, and terminal areas 
defined as the Columbia mainstem upstream of McNary Dam, the Snake River  mainstem, and within the 
subbasins. 
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among populations.  Ocean, mainstem and terminal fisheries are not mark- 
selective in the current condition. 

The HSRG Solution modified harvest rates to include mark –selective fisheries in 
Washington and Oregon marine areas, the Columbia River mainstem, and 
terminal areas.  The analysis assumed a 20 percent marine non-selective harvest 
rate in Canadian and Alaskan waters and a 20 percent selective harvest rate on 
hatchery fish in Washington and Oregon marine waters (2:1 selective 
differential).  In the mainstem Columbia River, the HSRG assumed a 20 percent 
selective harvest rate on hatchery fish and a 5:1 selective differential. 

Lower Columbia River Spring Chinook 
This stock group has a moderately high ocean harvest rate of approximately 30 
percent.  All mainstem and terminal fisheries are mark-selective for hatchery 
fish.  Harvest impacts on unmarked natural fish are from incidental non-landed 
mortality (5 percent).  The harvest rates assumed for the terminal areas were 
provided by the managers and ranged from 30 – 50 percent  on marked hatchery 
fish and 5 percent incidental mortality on unmarked natural-origin Chinook. 

The HSRG Solution assumed no changes to harvest rates. 

Willamette River Spring Chinook 
The stock group has an ocean harvest rate of approximately 10 percent.  
Mainstem Columbia and Willamette tributary fisheries have a total allowable 
impact limit of 15 percent on unmarked natural-origin fish.  All mainstem and 
terminal fisheries are mark-selective for hatchery fish.  The harvest rates assumed 
for the terminal areas were provided by ODFW and were 20 percent on marked 
hatchery fish and 2 percent incidental mortality on unmarked natural-origin 
Chinook. 

The HSRG Solution assumed no changes to harvest rates. 

Middle and Upper Columbia Spring Chinook 
The HSRG analysis assumed a nominal one percent ocean impact to account for 
the few recoveries reported in the coded-wire tag database.  In-river fisheries are 
managed on a sliding scale based on abundance of returning adults.  The HSRG 
analysis is based on recent year averages.  The Lower Columbia River harvest is 
selective for marked hatchery adults.  Harvest on marked hatchery adults was 
assumed to be 8 percent and a maximum 2 percent allowable impact (non-landed 
mortality) was assumed on unmarked natural-origin adults.  Upper Columbia 
River harvest is a non-selective treaty fishery with an assumed harvest rate of 8 
percent on hatchery and natural-origin adults.  Terminal area fisheries included 
non-selective treaty and mark-selective sport fisheries.  Harvest rates ranged 
from 0 – 42 percent on hatchery-origin spring Chinook in the Wenatchee River.  
Terminal harvest rates were provided by the managers.  

The HSRG Solution assumed no changes to harvest rates. 

Upper Columbia Bright Fall Chinook 
Harvest rates for this stock group were based on recent year averages provided 
by the Columbia River Joint Staff Technical Advisory Committee.  None of the 



  
 

Columbia River Hatchery Reform Project 
Final Systemwide Report – Appendix D 
User Guide  Page 35 

fisheries are mark-selective.  Ocean harvest rates used in the analysis were 
approximately 40 percent for all populations.  Lower Columbia River harvest 
rates ranged from 6 – 8 percent depending on the population.  The Yakama 
Nation provided Lower Columbia River harvest rate information for Klickitat fall 
Chinook that was closer to 18 percent.  The Upper Columbia harvest rate on this 
group was assumed to be 16 percent.  Terminal area harvest rates were provided 
by the managers and ranged from 3 to 30 percent.   

The HSRG Solution assumed no changes to harvest rates.  

Upper Columbia Summer Chinook 
Harvest rates for this population group were based on recent year averages 
provided by the Columbia River Joint Staff Technical Advisory Committee.  
None of the fisheries are mark-selective.  The ocean rate used in the analysis was 
43 percent for all populations.  Lower Columbia River harvest rates were 
assumed to be 5 percent.  The Upper Columbia harvest rate on this group was 
assumed to be 10 percent.  Terminal harvest (including the mainstem Columbia 
River harvest upstream of McNary Dam) was 1 – 15 percent.   

The HSRG Solution harvest rates for the ocean and upper Columbia River were 
based on the recently signed US-Canada Treaty and the U.S. v. Oregon 
agreement.  Rates in the ocean were decreased to 40 percent and the upper 
Columbia River harvest rate increased to 23 percent.  The HSRG Solution 
recommended implementing a mark-selective fishery in the Lower Columbia 
River with a 2 percent rate on unmarked natural-origin adults and 9 percent on 
marked hatchery-origin adults.  The HSRG Solution included mark-selective 
fisheries in the terminal areas. 

Snake River Bright Fall Chinook 
Harvest rates for this population were provided by NOAA.  Ocean harvest rates 
were 31 percent, Lower Columbia River rates 6 percent, and upper Columbia 
River rates were 16 percent.  Total exploitation rate on this population was 
assumed to be 47.5percent. 

The HSRG Solution assumed no changes to harvest rates.  The HSRG 
recommended implementing a mark-selective fishery in the Snake River and 
assumed a 2 percent incidental mortality on unmarked natural-origin fish and a 
20 percent harvest rate on marked hatchery-origin fish. 

Snake River Spring/Summer Chinook 
The HSRG analysis assumed a nominal one percent ocean impact to account for 
the few recoveries reported in the coded-wire tag database.  In-river fisheries are 
managed on a sliding scale based on abundance of returning adults. The HSRG 
analysis is based on recent year averages.  The Lower Columbia River harvest is 
selective for marked hatchery adults.  Harvest on marked hatchery adults was 
assumed to be 8 percent and a maximum allowable impact (non-landed 
mortality) on unmarked adults of 2 percent.  Upper Columbia River harvest is a 
non-selective treaty fishery with an assumed harvest rate of 8 percent.  Terminal 
area fisheries included non-selective treaty and selective sport fisheries.  Harvest 
rates ranged from 30 – 50 percent on hatchery-origin adults and 0 – 10 percent on 
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natural-origin adults depending on the population.  Terminal harvest rates were 
provided by the managers.  

The HSRG Solution assumed no changes to harvest rates in the ocean, lower 
river and upper river fisheries.  The HSRG recommended higher terminal harvest 
rates on marked hatchery-origin adults on several populations. 

 Columbia River Chum 
Harvest of chum salmon is incidental, occurring primarily in the lower Columbia 
River commercial coho fishery.  Sport harvest of chum in the Columbia River 
and tributaries has been closed since 1992 in Oregon and 1995 in Washington.  
The analysis assumed that chum salmon are not harvested in the ocean or in the 
Columbia River above Bonneville Dam.  Fishery managers set a 5 percent 
maximum incidental harvest mortality on Columbia River chum.  Recent harvest 
rates are reported to have averaged about 1.6 percent annually.  The HSRG 
analysis assumed a 2 percent incidental harvest impact on chum. 

The HSRG Solution assumed no changes to harvest rates. 

Columbia River Coho 
Harvest on Columbia River coho is selective in the ocean and Lower Columbia 
fisheries.  Conclusive information on harvest rates on marked hatchery-origin 
adults and unmarked natural-origin adults was not available to the HSRG.  
Observed ocean and mainstem combined harvest impacts on natural-origin coho 
have ranged from 11 – 20 percent.  The HSRG analysis assumed a 15 percent 
combined harvest rate.  Harvest rates on marked hatchery-origin coho are less 
clear.  Analysis of a coded-wire tag datasets for a few double index tagged 
populations suggested a much higher differential in harvest rates than used in the 
analysis (WDFW unpublished information).  The analysis used a combined 
(ocean and mainstem) harvest impact of 35 percent on marked coho.  Terminal 
area harvest rates were provided by the managers and ranged from 2 percent on 
natural-origin adults to over 90 percent in the commercial gillnet fishery on 
hatchery-origin adults returning to Youngs Bay net pens.  

The HSRG Solution assumed an increased selective harvest on marked hatchery 
coho in ocean and lower Columbia River fisheries.  The ocean harvest rate on 
unmarked natural-origin fish increased slightly associated with the increase in 
selective harvest on marked-hatchery-origin adults.  Lower Columbia fisheries 
were assumed to be more selective on marked hatchery adults, resulting in a 
decrease in harvest rate on natural-origin adults and an increase in harvest rate on 
hatchery-origin adults.  The combined ocean and mainstem harvest impact on 
natural-origin fish was assumed to remain unchanged at 15 percent and to 
increase to 55 percent on marked hatchery-origin fish.  

Snake River Sockeye 
Harvest on Snake River sockeye was based on the recent year incidental impact 
of three percent in Columbia mainstem fisheries.  Recent year impacts were 
described in the annual Joint Staff reports.  

The HSRG Solution assumed no changes to harvest rates. 
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Wenatchee River Sockeye 
Harvest on Wenatchee River sockeye was based on the recent year incidental 
impact of three percent in Columbia mainstem fisheries.  Recent year impacts 
were described in the annual Joint Staff reports.  The occasional terminal fishery 
was considered to be so infrequent that it was not included in the analysis. 

The HSRG Solution assumed no changes to harvest rates. 

Columbia River Winter Steelhead 
This population group included winter steelhead in the Lower Columbia, 
Willamette River, and Columbia Gorge.  The HSRG analysis assumed a nominal 
one percent ocean impact to account for the few recoveries of steelhead in ocean 
fisheries.  Allowable impacts on natural-origin steelhead in the mainstem 
Columbia River have ranged from 2 – 6 percent.  The HSRG analysis assumed a 
4 percent incidental harvest rate in the lower Columbia on natural-origin 
steelhead.  Terminal fisheries are mark-selective for hatchery-origin adults.  
Terminal area harvest rates were provided by the managers and ranged from 30 – 
80 percent on hatchery-origin adults and less than 10 percent incidental mortality 
on natural-origin adults. 

The HSRG Solution assumed no changes to harvest rates. 

Lower Columbia River Summer Steelhead 
This population group included mostly hatchery-origin summer steelhead in the 
Lower Columbia and Willamette River.  Natural-origin summer steelhead return 
to the Kalama, Lewis, Washougal, Hood and Wind rivers.  The HSRG analysis 
assumed a nominal 0.5 percent ocean impact to account for the few recoveries of 
steelhead in ocean fisheries.  Recent NOAA biological opinions for natural-
origin steelhead have allowed a 2 percent harvest impact during the summer 
period and 2 percent in the fall period for a total harvest impact of 4 percent in 
the lower Columbia River.  These impacts are non-landed mortality as all 
fisheries are mark-selective for hatchery fish.  The analysis assumed a 10 percent 
harvest rate in the upper Columbia River on populations upstream of Bonneville 
Dam.  This harvest rate was provided by managers based on PIT recoveries at 
Bonneville Dam and in the subbasin.  Terminal area harvest rates were provided 
by the managers and ranged from 30 – 80 percent on hatchery-origin adults and 
less than 10 percent incidental mortality on natural-origin adults. 

The HSRG Solution assumed no changes to harvest rates. 

Middle and Upper Columbia River Summer Steelhead 
This population group included populations in the Middle Columbia Steelhead 
DPS and the Upper Columbia Steelhead DPS.  The HSRG analysis assumed a 
nominal 0.5 percent ocean impact to account for the few recoveries of steelhead 
in ocean fisheries.  The analysis assumed a 1 percent incidental harvest rate on 
natural-origin adults in the lower Columbia River fishery and a 4 percent harvest 
rate on marked hatchery-origin adults.  The analysis used an 8 percent harvest 
rate in the upper Columbia River on hatchery-origin adults and a 4 percent 
harvest rate on natural-origin adults.  These rates were based on recent year 
averages and allowable impacts described in NOAA biological opinions.  
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Terminal area harvest rates were provided by the managers and ranged from 30 – 
80 percent on hatchery-origin adults and less than 10 percent incidental mortality 
on natural-origin adults.  The exception was the Klickitat River where the 
terminal steelhead fishery includes a tribal harvest with a harvest rate of 
approximately 30 percent (YN unpublished data).   

The HSRG Solution assumed no changes to harvest rates in the lower Columbia 
or upper Columbia fisheries.  The HSRG recommended higher terminal harvest 
rates on hatchery-origin adults in several subbasins. 

Snake River Basin Steelhead 
This population group included A-run and B-run steelhead returning to subbasins 
in Washington, Oregon and Idaho.  The HSRG analysis assumed a nominal one 
percent ocean impact to account for the few recoveries of steelhead in ocean 
fisheries.  The analysis assumed a one percent incidental harvest rate on natural-
origin adults in the lower Columbia River fishery and a 4 percent harvest rate on 
marked hatchery-origin adults.  Slightly higher rates were used for Lyons Ferry 
hatchery steelhead based on information provided by WDFW.  For A-run 
steelhead the analysis used an 8 percent harvest rate in the upper Columbia River 
on hatchery-origin adults and a 4 percent harvest rate on natural-origin adults.  
For B-run steelhead the analysis used a 14 percent harvest rate in the upper 
Columbia on hatchery-origin and natural-origin adults (non-selective).  These 
rates were based on recent year averages and allowable impacts described in 
NOAA biological opinions.  Terminal fisheries are mark-selective for hatchery-
origin adults.  Terminal area harvest rates were provided by the managers and 
approximately 60 percent on hatchery-origin adults and 3 percent incidental 
mortality on natural-origin adults. 

The HSRG Solution assumed no changes to harvest rates in the lower Columbia 
or upper Columbia fisheries.  The HSRG recommended higher terminal harvest 
rates on hatchery-origin adults in several subbasins. 



  
 

Columbia River Hatchery Reform Project 
Final Systemwide Report – Appendix D 
User Guide  Page 39 

 

2 Information management 
Information management consists of storing and retrieving information used in 
the analysis from the project web site (ww.hatcheryreform.us) and running 
analyses with the offline All H Analyzer (AHA) application.  The next two 
sections describe the online web site application and how to run the offline AHA 
application. 

2.1 Web Site User Guide  
This user's guide explains how to use the All H Analyzer (AHA v. 13) data 
management tools accessible from the Hatchery Reform website 
(www.hatcheryreform.us). The website tools allow hatchery managers, agency 
personnel, planners, and members of the public to obtain the offline AHA 
application and datasets necessary to review and update an AHA analysis. 

The AHA tool is used to evaluate management strategies for salmon and 
steelhead populations in the Pacific Northwest. This guide does not address in 
detail use of the AHA tool. That information may be found in Section 2.2 of this 
User’s Guide. 

2.1.1 Background 
The AHA tool has been used by the HSRG to organize information and evaluate 
the effects of hatchery operations, harvest, mainstem passage survival 
(hydropower) and habitat conditions on populations of salmon and steelhead in 
the Columbia Basin, as well as to develop recommendations to better achieve 
goals identified by managers.    

The Columbia River Hatchery Reform System-wide Report details the results of 
the HSRG review of all salmonid hatcheries and hatchery programs in the U.S. 
portion of the Columbia River Basin.  It contains a description of principles and 
recommendations advocated by the HSRG and a discussion of how to analyze a 
hatchery program to determine the “best” solution for achieving conservation and 
harvest goals.  This Hatchery Reform Project website is one of the 
recommendations that grew out of the HSRG review.  

2.1.2 Who may use the hatchery reform website? 
Portions of the hatchery reform website, including population data files, global 
datasets, the AHA tool, and supporting documentation, are available to all users.  
Uploading new population datasets and global datasets is restricted to users with 
administrative privileges.   

2.1.3 How to get help with the website 
Users may obtain help with the site by contacting the Hatchery Reform 
webmaster. 

2.1.4 The AHA Tool  
The All-H Analyzer tool (AHA v. 13) is a stand-alone Microsoft Excel-based 
desktop application which can be downloaded for free on this website.   The 

http://www.hatcheryreform.us/
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All-H Analyzer refers to the four “Hs” which comprise the main influences on 
salmonid populations in the Columbia River Basin:  habitat, harvest, hatcheries, 
and passage through hydroelectric dams.  The tool contains calculations and 
summary graphics of salmon fisheries characteristics based on: 

• Habitat patterns 

• Harvest patterns 

• Hydroelectric dam operation patterns 

• Hatchery operations 

AHA estimates reflect a measure of hatchery influence on natural populations 
that is a function of both the percent hatchery-origin spawners in the natural 
escapement and the percent of natural-origin broodstock incorporated into the 
hatchery program (Appendix C, System-wide Report).  

The purpose of the AHA tool is to allow managers to explore the implications of 
alternative ways of balancing hatcheries, harvest, habitat, and hydrosystem 
constraints. This tool is not used to make decisions nor is it used to judge the 
“correctness” of management policies. Rather, it illustrates the implications of 
alternative ways of balancing the four “Hs” so that informed decisions can be 
made.  AHA should not be viewed as a “new” tool to predict habitat, harvest or 
hydroelectric system effects on salmonid populations; it really is a platform for 
integration of existing analyses. It is a relatively simple aid to regional decision-
making which can rapidly explore the potential impacts of a variety of detailed 
scenarios relating to one or more “Hs”. 

2.1.5 Data Sets 
The AHA tool uses the file types shown in Table 6. 

Table 6.  AHA application file types 

File Type  Suffix Format Contents 

Hatchery/Population Data  *.rol text Data for multiple scenarios for a hatchery program/natural 
population 

Stray Matrix File  *.smx xml Global data that describes stray rates of hatchery adults 

Habitat Pattern Dataset File *.hab xml Global habitat data 

Harvest Pattern Dataset 
File 

*.hrv xml Global harvest data 

Hydro Pattern Dataset File *.hyd xml Global hydroelectric operation data 

 

The hatchery/population dataset contains data from all Columbia basin 
populations and hatchery programs for the selected species.  The dataset contains 
a six-scenario “6-pack”.  The first scenario of the 6-pack is always the current 
condition and the sixth scenario is always the historic condition. The user has 
options to load the open slots with scenario information available from the web 



  
 

site. Population/Hatchery datasets are discussed further in the next section of this 
guide.  

The global datasets contain data that describe the following: 

• Stray Matrix - Assumed stray rates of hatchery adult populations 

• Habitat - Productivity/capacity inputs 

• Harvest - Harvest rates  

• Hydro - Mainstem passage and ocean survival of juveniles and adults 

2.1.6 Step-by-Step Guide to the Hatchery Reform Website Data Tools 

 Note:  Users do not need to login to download Data Sets, the AHA 
tool, or supporting documentation. Users must have login credentials to 
upload datasets to the central database.  

Accessing the Tools Page:             

Home>Analytical Tools>AHA v.13 
On the Home page, click the Analytical Tools tab then select AHA v.13 from 
the dropdown menu.  This will bring the user to the “All-H” Analyzer Tools 
Page which provides access to the central database to allow the user to download 
AHA datasets (Figure 1). Credentialed users (administrators) may download and 
upload datasets.  
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Figure 1.  Hatchery Reform Website Home Page. 

Using the AHA v. 13 Tools:  Tasks for All Users 
Links on the AHA Tools Page allow all users to download files required to begin a 
new AHA session or update global data for an existing AHA session.  For 
administrators, the tools page provides links to upload the latest global datasets 
and AHA scenarios contained in a hatchery/population file.   

Getting Started Wizard 
The Getting Started link allows AHA users to download a complete file 
package in *.zip format (Figure 2).  The package contains current versions of the 
datasets listed in Table 1, the AHA application, and the supporting 
documentation needed to start an AHA session. The process is completed in 3 
steps: 
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Figure 2.  Getting Started Wizard. 
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Getting Started>Step 1 of 3:  Choose Species   
Select the species from the box on the left (Figure 3); then click Continue to 
proceed to Step 2 of 3. 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.  Select species. 
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>Step 2 of 3:  Configure 6‐pack 
The six scenarios contained in a hatchery/population file are referred to as a “6-
pack.”  Four scenarios are selected by the user from dropdown menus associated 
with slots 2 through 5. As mentioned previously, slot 1 is always the current 
condition and slot 6 is always the historic condition.  The choices associated with 
slots 2 through 5 are either specifically or generically named scenarios (Figure 
4).  Scenarios with an assigned name, e.g. “HSRG Sol”, indicate a scenario with 
specific assumptions representing an analytical solution. The user may also 
download a working scenario with inputs for one of the scenarios (e.g., multiple 
copies of the current scenario).  A user can edit inputs for any scenario in a 
dataset, however most users may want to retain the information for a particular 
scenario and create a new scenario to evaluate different strategies.  
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Figure 4.  Select four of six scenarios to download. 

Selecting a generic scenario will produce a second column to the right of the first 
column.  From the dropdown menu, the user is prompted to select the base 
scenario. This base scenario defines the starting conditions for the user when 
working with the editable scenario.  

 



  
 

   Note that all slots must be filled and that entries must be unique.  

Here is an example of producing a scenario 6-pack.   The user has made the 
following selections for the selectable slots shown in Figure 5: 

Slot 1: This is always the Current scenario.  The user may not select 
another scenario. 

Slot 2: “No Hat” scenario was selected by user. This scenario represents 
a specific scenario in the database. 

Slot 3:  The user has selected the HSRG Sol scenario.  This scenario 
represents a specific scenario in the database.  

Slot 4:  The user has selected a “working” scenario based on the 
HSRG+Hab Scenario. 

Slot 5: The user has selected a “working” scenario based on the Current 
Scenario (Slot 1).  

Slot 6: This is always the Historic scenario. The user may not select 
another scenario.  

After each slot is filled, the user clicks the button marked Continue on the lower 
left of the panel to proceed to Step 3 of 3.  

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.  Fully configured 6-pack. 
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>>Step 3 of 3: Download 
Through a link on the Download page, the user can access the configured AHA 
dataset (6-pack) package (Figure 6).  The package contains the following: 

• Scenarios specified on the Configure 6-pack page in a 
hatchery/population file. 

• Four global datasets 

• The AHA application 

• Supporting documentation 

 

 

 

 

 

 

 

 

 

 

 

 

   

Figure 6.  Click link to download zip file. 
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Download Global Data Wizard 

  Tools>Download Global Datasets>choose data sets 
Choosing this link allows the user to download the current global data sets.  
Downloading the current global datasets allows the user to update an existing 
AHA session.  From the main Tools page, select Download Global Datasets 
(Figure 7).  The new page will have links for Stray Matrix, Habitat Patterns, 
Harvest Patterns, and Hydro Patterns (Figure 8).  Click on any of the links to 
download the current global data set to your hard drive.   

Note that the filenames are date-stamped, allowing the user to determine 
if global datasets used in their AHA session are outdated 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 7.  Global Data Download Wizard. 
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Figure 8.  Select global data file to download. 

 

Using the AHA Tools:  Tasks for Administrative Users 
This section outlines the procedure for uploading datasets to the central 
database.  These activities are for administrators only.  Administrators must 
have login credentials to use the upload tools.  

Note that uploading any dataset will replace the existing dataset in the 
system.  

Logging In 

Any website page>Account Management>Login 
On any of the website pages, click on the Login button below the Accounts 
Management heading (Figure 9).  The Login page appears.  Enter your name and 
password in the provided boxes and click on Login (Figure 10). 
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Figure 9.  Login link. 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 10.  Enter username and password. 
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Under the heading “Administrative Tasks (administrators only)”, there are 5 links which 
may be used to upload files to the remote database: 

• Upload Global Habitat Pattern Dataset 

• Upload Global Harvest Pattern Dataset 

• Upload Global Hydro Pattern Dataset 

• Upload Stray Matrix Dataset 

• Upload Hatchery Scenario Data 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 11.  Administrative Tasks links. 

The first four links allow the user to upload global datasets; the last link allows 
the user to upload an AHA hatchery/population file.  Note that uploading a 
global dataset will replace the current dataset in the central database. 
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Upload Global Data 
To upload global datasets: 

1. Select type dataset to upload. A page similar to Figure 12 will load. 

2. Browse to the location of global dataset. 

3. Click Upload 

4. Use the same procedure to upload any of the four global datasets. 

 

 

Figure 12.  Select global dataset to upload. 

A confirmation page with a unique dataset ID will appear after a successful 
upload. The dataset ID is referenced by the AHA scenarios to ensure scenarios 
are based on the current global datasets. The significance of referencing a correct 
dataset ID is discussed in the following section. 
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Upload Hatchery/Population Scenario Data 
To upload hatchery/population scenario data: 

1. From the Analytical Tools page, click the Upload Hatchery Scenario 
link. 

2. Browse to the scenario 6-pack file. 

3. Click Upload. 

4. If the global dataset IDs in the hatchery/population file match those of 
the global datasets, the user is then prompted to specify which scenarios 
in the dataset to upload (Figure 13).  

5. Note: If the global dataset IDs in the hatchery/population file do not 
match the current global dataset IDs, an error message similar to that 
shown in Figure 14 will be displayed. Synchronization of dataset IDs is 
discussed in the next section. 

6. After selecting scenarios to upload, click Upload. A confirmation page 
will appear indicating a successful upload. 

 

 
 
Figure 13.  Select scenarios to upload. 
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Figure 14.  Error message caused by unsynchronized global dataset IDs. 

Synchronizing Global Dataset IDs 
As mentioned previously, an upload error is generated if pattern dataset IDs in 
the hatchery/population file do not match the respective IDs in each of the 
current global datasets.  The user must synchronize the pattern IDs in the 
hatchery/population file with the current pattern datasets using one of the two 
methods outlined below: 

 Method 1: If the  scenarios are intended to be based on the global 
datasets currently in the central database, the user should update the 
local global datasets on their computer and synchronize the 
hatchery/population file following this procedure: 

1. Download the current global datasets from the hatchery reform website. 

2. Open a new offline AHA session. 

3. Load the downloaded datasets into the AHA tool. (This procedure is 
discussed in detail in the AHA User’s Manual, Section 2.2.4, Appendix 
D of the System-Wide Report. 

4. Reload the hatchery/population file into AHA. The AHA tool will 
automatically update the patterns IDs in the file. 

5. Re-save the hatchery/population dataset to be uploaded. 
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6. Upload the hatchery/population file following steps 1-5, Upload 
Hatchery Scenario Data.  

 
 Method 2: If the  scenarios are based on global datasets newer than 

those currently in the central database, the user should first update the 
global datasets in the central database and synchronize the scenario file 
following the procedure outlined below:  

1. Upload the new global datasets used in the AHA session. 

2. Download those same global datasets from the website. A new pattern ID 
will be generated indicating the global datasets originated from the 
central database.  

3. Load the downloaded global datasets into the user’s current AHA 
session. 

4. Resave the hatchery/population dataset to be uploaded. 

5. Follow steps 1-5, Upload Hatchery Scenario Data. 

 

Population Management Tools 
This section discusses the population management tools accessible from the 
Hatchery Reform website. All users are able to view population data. Users with 
login credentials are permitted to add and modify populations. 

The population management tools allow users to add new populations, view and 
edit existing populations, and disable (but not delete) populations. In addition, 
users may view a population modification history table. Users should be aware 
that once a population is added or modified additional data synchronization is 
required using the offline AHA tool. 

To access the population tools, select the Population Management link from the 
Analytical Tools tab: 

Analytical Tools > Population Management 
A page similar to that shown in Figure 15 will load. 



  
 

 
Figure 15.  Population Management main page. 

 

Create Population 
To create a new population, click the Create Population link from the Population 
Management main page. The user will be prompted to login if they haven’t 
already done so. A page similar to that shown in Figure 16 will load.  

The user is required to provide the following information: 

• Population Name – Enter the name of the new population. The mythical 
salmon population Sullivan’s Gulch Chinook is shown as an example in 
Figure 2. 

• User Name – The user is required to enter their name in this field. This 
information is necessary to identify to person posting the data as 
Hatchery Reform website login accounts may have several individual 
users. 

• Explanation – The user should enter a brief description of the new 
population in this field. The description may contain up to 1024 
characters.      

Once the fields are complete, click Continue. 
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Figure 16.  Step 1 of 3, enter required data. 

 

 

In the second step, the user is prompted to confirm that the submitted data are 
correct. This is shown in Figure 17.  If the information is correct, click Continue 
and a page indicating success will load (Figure 18). Note that a unique identifier 
is generated for the new population. 
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Figure 17.  Confirm submitted data. 

 
 
 

 
Figure 18.  Confirmation page. 

 

View Population Modification History 
The View History table lists modification actions for all populations. Users may 
view the table without logging in.   

To access the View History Table, click the link on the Population Management 
Tools main page (Figure 15). A page similar to that shown in Figure 19 will load. 
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Figure 19.  Population Modification History page. 

 
The table has seven columns: 

• Date – The date and time the modification was made. 

• Type – The type of modification. Possible values are CREATE, 
RENAME, and DISABLE. 

• Account – The login account used to access the Hatchery Reform 
website tools. 

• ID – The unique identifier assigned to the modification event. 

• Name – The population name. 

• Full Name – The person responsible for the modification. 

• Explanation – Explanatory notes. 

 

Modify an Existing Population 
To view enabled populations in the Hatchery Reform database, click on the 
Rename or Disable an Existing Population link found on the Population 
Management main page (Figure 15). A page similar to that shown in Figure 20 
will load.  

Users with login credentials are permitted to edit the population name or disable 
the population entirely. To rename an existing population, click on the Rename 
link in the Action column next to the population to be modified.  The example 
shown in Figures 21 through 23 renames the Sullivan’s Gulch population from 
“Chinook” to Coho”.  
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Figure 20.  Step 1, rename population. 

 
 
 

 
Figure 21.  Step 1, rename population. 
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Figure 22.  Step 2, confirm edits. 

 
 
 

 
Figure 23.  Step 3, confirmation page. 

To disable a population, click the Disable link next to the population name in the 
main page table.  If the Disable links are grayed out, additional steps are required 
as population cannot be disabled until all datasets that reference it are first edited.  

To delete references to the population, the user must edit each file that references 
that population using the offline AHA tool. These files will include one or more 
of the pattern datasets, as well as a population-hatchery data file (formerly called 
a rollup file). Once the population references are deleted, the files must be 
uploaded using the HRP website upload tools. After a successful upload, the 
disable link become active, and the population can then be disabled.  Note that 
disabling a population removes it from the table on the main page but does not 
delete it from the underlying data tables.  
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2.2 Offline All H Analyzer User Guide 

2.2.1 Introduction 
The “All H Analyzer” (AHA) program is the primary tool used to evaluate 
strategy options for hatcheries, habitat, harvest, and hydroelectric system out-of-
basin survival (hydro, estuary, and ocean) for a single population and across 
multiple populations. This user guide was developed for AHA Version 13.0 
(December 2008) (Figure 24). 

 
Figure 24.  AHA open screen providing version number and contact information. 

AHA was developed by Washington State fishery co-managers to facilitate the 
discussion of strategy options to restore and to manage salmon populations in the 
Pacific Northwest. AHA allows managers to explore the implications of 
balancing habitat restoration, hatchery practices, harvest, and hydroelectric dam 
operations in different ways, while simultaneously modeling the multiple 
interactions among populations given the manipulations of the Hs.  

AHA should not be viewed as a new model, but rather as an application for 
combining information from observations and from existing models.  The 
program makes relatively few new assumptions; rather, it brings together the 
results of other models such as EDT or stock recruit models for habitat, 
SIMPASS for Columbia River hydroelectric passage, and others.  It does not 
replace these other models, but instead relies on them to provide inputs to the 
analysis.  The inputs are relatively simple, so it is fast and easy to use, while 
focusing on the important elements of regional decision making regarding the 
four Hs. 

Who Will Use AHA 
AHA is intended primarily for technical users evaluating strategies for a single 
population and across multiple populations.  
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What Users Should Know 
Users should have a familiarity with the previous generation of this program: the 
single population AHA application (program versions 1 through 12).  More 
information about AHA is available at the Hatchery Reform web site 
(http://www.hatcheryreform.us). 

What Software and Hardware Will Be Needed 
AHA was programmed in Microsoft Excel Visual Basic for Applications (Excel 
VBA). It requires Microsoft Office 2000, 2003, or 2007.  We have observed that 
AHA will perform calculations two to three times faster under Excel 2000 or 
2003 compared to Excel 2007.  The difference in overall calculation speed can be 
quite significant, depending on the speed of a computer’s CPU and the number of 
populations in the analysis.  It is possible to install Excel 2003 concurrently with 
Excel 2007 if faster performance is desired.  The screens in AHA were designed 
for a resolution of 1280 x 1024. However, other resolutions will also work by 
adjusting the Zoom setting in Excel to see more of the page.  The zoom can be 
set in any active program window using the keystrokes Control + “[“ (Ctrl + ]) or 
Control + “]” (Ctrl + ]).  

What Data Needed 
When using the program for the first time, AHA will require five files in order to 
use all functions available in the program.  All five of these files are available on 
the Hatchery Reform web site: http://www.hatcheryreform.us.  Instructions for 
downloading these files were described previously in Section 2.1 of this 
appendix. 

Files required for all AHA sessions: 

Species multiple population file (*.rol file format).  Note: multiple single-
population *.aha8 files from the previous generation of the program can also be 
used. 

Global pattern and stray matrix files are required for the first AHA session after 
downloading the application.  Specifically these files are: 

• Stray matrix file (*.smx file format) 

• Hydro pattern file (*.hyd file format) 

• Harvest pattern file (*.hrv file format) 

• Habitat pattern file (*.hab file format) 

Once a stray matrix file and the three types of pattern files listed below have been 
loaded, they will not need to be loaded again to use the features of the program.  
We recommend loading periodic updates from files available at the Hatchery 
Reform website.   

                                                 
8 The single population dataset is created from a previous version of the AHA 
application, or by saving an AHA Rollup session into single population files (see Saving 
Files later in this User Guide). Single population datasets have a *.aha extension. 

http://www.hatcheryreform.us/
http://www.hatcheryreform.us/
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Datasets for multiple populations are created from an AHA session and contain 
information for all populations.   

2.2.2 Before Beginning 
To download the AHA program, go to the Hatchery Reform web site 
(http://www.hatcheryreform.us).  AHA is constructed in Microsoft Excel.  
Installing AHA is nothing more than unzipping the application file 
(AHA_V13.xls) to a location on your local hard drive.  AHA dataset files can be 
in the same location as the application or in a separate location.  These files 
should be stored in a location where they will be easily accessible later so they 
may be loaded into the application. 

Launching the AHA Program 
We recommend closing other files within a given instance of Excel before 
running AHA.  Other Excel workbook files may be run concurrently with AHA, 
but for best performance they should be in separate instances of the Excel 
application.  In other words, if an Excel workbook is open and the user wants to 
keep it open, simply launch a second instance of the Excel program in a separate 
window and use the open menu item from that second instance to open AHA.  
This should avoid most conflicts that could occur from macros running in AHA 
or other Excel workbooks.   

Open AHA program by double clicking the AHA_V13.xls file or by opening the 
file via Excel. 

Macro Security Levels in Excel 
If the Excel 2003 macro security level is set to medium, a security message will 
appear when the AHA application is opened.  This message will ask if the user 
would like to enable macros in the file. The AHA program will not work if 
macros are not enabled, so select “Enable Macros”.  If a message requesting to 
enable macros does not appear, then the security settings may be set at High or 
Very high.  If so, at the top of Excel 2003’s menu bar, go to Tools→ Macros→ 
Security and set the level to Medium in Excel 2003.  Next close AHA and then 
reopen the application. The message asking to enable macros should appear. 

If using Excel 2007, a security message will appear immediately below the 
Ribbon in Excel; click “Options” to enable content. If the security message does 
not appear, go to Developer → Macro Security and set the level to “Disable all 
Macros with Notification”.  Next close AHA and then reopen the application.  
The message asking to enable macros should appear.  

Opening AHA 
The application opens to the AHA welcome page, also called the Landing Page 
under the View menu option (Figure 25).  This view includes populations 
filtering options which allow you to filter the population list by ESU, Region, or 
Species (more on this later). 

 
 

 

http://www.hatcheryreform.us/


  
 

 

Figure 25.  AHA Landing Page. 

2.2.3 Application Map 
Four screens make-up the core AHA application (Figure 26).  AHA always opens 
with the landing page and depending on the user’s need, the user can either go 
directly to the Population Page to scroll through the populations and view/edit 
each individually, remain on the Landing Page to set the filters and view results 
combined for all populations, navigate to the Global Page to manage patterns to 
affect multiple populations, or navigate to the Strategy Page to manage 
populations and view/edit hatchery and stray information.  The order of these 
steps is entirely up to the user.  

Navigation between the screens is by the menu bar at the top of the application.  
Note that the menu bar appears under the “Add-Ins” Ribbon in Excel 2007.  
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Landing Page
View Population summaries
Filter populations for ESU,
Region, Subbasin, or Species

Global Page
Select and manage global
patterns

Strategy Page
View and edit hatchery information
View and edit population list
Apply stray assumptions

Population Page
View and edit all H information
for a single population

Hatchery Component
View/edit hatchery inputs

Natural Component
View/edit natural inputs

Fitness Component
View fitness inputs

 
Figure 26.  AHA application map. 
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2.2.4 Running AHA: A Quick-Start Primer in 5 Easy Steps. 
A Quick-Start overview has been provided to help users get started without 
having to read the entire user guide.  These five steps are sufficient to get started 
to the point the information can be viewed/edited and a dataset can be saved.  
The user is strongly encouraged to review the entire guide once he/she is 
comfortable with the application basics.  

Step 1. Go to the Hatchery Reform web site to download data files. 
 

The website is accessible from the offline application file menu (Figure 27):             

 
 
Figure 27.  Navigation to the application online web site. 

Microsoft Internet Explorer Version 4 or later must be installed to use this 
feature. 

Or go to http://www.hatcheryreform.us  

Follow the instructions on the website and in Section 2.0 of this appendix to 
download the following five file types: 

• Species population files (*.rol file format), for one or more species.  
These files contain all available population data for a given species 
(Chinook, Coho, Chum, Steelhead, and Sockeye). 

• Stray matrix file (*.smx file format) 

• Hydro pattern file (*.hyd file format) 

• Harvest pattern file (*.hrv file format) 

• Habitat pattern file (*.hab file format) 

Step 2. Open the files in AHA. 
 

From the application file menu to go to File > Open (Figure 28).                       

 
 
Figure 28.  Navigation to File>Open to load data into the offline application. 
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The file dialog box will appear to locate files to load (Figure 29). 

 
Figure 29  The file dialog box to load files into the offline application. 

Next, browse to the location of the *.rol file that has just downloaded (Figure 
30). 

 
 
Figure 30.  Locate file dialog box. 

Now do the same for the Stray matrix and Pattern files (Figure 31): 
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Figure 31.  Portion of dialog box to locate stray and pattern files. 

The dialog box should be completed with file information for the corresponding 
data sources (Figure 32). 

 
 
Figure 32.  Completed file dialog box ready to load files. 

The selected data is now ready to load into AHA.   

Click the “Load” button at the top of Figure D-9 to begin loading the files.  The 
status bar at the bottom-left of the AHA window will update as the load 
progresses. 

Step 3.  View the data summary and Filter Populations on the Landing Page 
 

Once data is loaded, the Welcome Page/Landing Page will look something like 
this Figure 33 with charts filled with data. 

Columbia River Hatchery Reform Project 
Final Systemwide Report – Appendix D 
User Guide  Page 69 



  
 

 
 
Figure 33.  The AHA offline application with data loaded. 

A summary of some of the important data contained in the *.rol file loaded now 
show in the data windowpanes.  The data view can be configured to the user’s 
liking, by simply selecting the chart caption from one of the corresponding four 
dropdown menus on the page Welcome/Landing page (Figure 34). 

 
 
Figure 34.  Dropdown menu choices for charts on Welcome/Landing page. 

Filter Populations by Region or ESU 
ESU and Region values from the dataset are listed in the dropdown menus at the 
top of the landing page (Figure 35).  First, Select from the radio buttons to filter 
populations by ESU, Region, or Species.  Once filter choices are complete then 
click the “Apply Filter” button next to the filter dropdowns. 
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Select an ESU to filter

Select a Province and Subbasin to
filter

Select a Species/Race to filter

 
 
Figure 35.  Filter populations in a dataset.  

Step 4.  View and Edit Single Populations (Legacy AHA view) 
 

The Single population AHA viewer is nearly identical to the previous generation 
of AHA, the functions of which have been integrated into this version of AHA.  
The main difference in the interface is that values in output cells update on an 
apply command, via the “Apply & Recalculate” button at the top of the screen.  
This will update and save to memory all data associated with this population. 

Navigation to the single-population view from the menu bar can be from either 
the Rollup Views menu item or the Population menu item (Figure 36).   

Or

 
 
Figure 36.  Navigation pathways to the AHA single population view. 

The single-population AHA view will display (Figure 37) for the first population 
in the dataset.  Note the population name in the upper left hand corner of the 
screen.  See Section 2.2.5 for more information about the Population screen. 
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Figure 37.  The single population AHA view. 

VERY IMPORTANT: BEFORE MOVING TO A DIFFERENT 
POPULATION OR ANOTHER SCREEN, FIRST CLICK THE “APPLY & 
RECALCULATE” BUTTON AT THE TOP OF THE SCREEN TO SAVE 
EDITS TO MEMORY. 

To move among populations use Ctrl + {Page Up/Page Down} to go up or down 
the list of populations in this (or any other) view. 

To apply edits to other populations via the stray matrix in the rollup, go to the 
“Redistribute Strays” menu option under the Strays menu (Figure 38).  

 
 
Figure 38.  Navigation to the Strays menu item. 
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To review the hatchery component of the selected population, from the menu bar 
go to the Hatchery Component menu item (Figure 39). 

 

Figure 39.  Navigation to the Hatchery Component menu item. 

 
This will display the Hatchery Component “QC” view, which displays input 
variables for the hatchery program.  Users will recognize these inputs from the 
previous generation of AHA (Figure 40). 

 
Figure 40.  The Hatchery Component screen for a single population. 
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Values in yellow cells can be edited, green cells are calculated values and cannot 
be edited.  Changes made to variables in this view can be recalculated for the 
selected population by clicking “Quick Recalculate” at the top of the screen, or 
applied to the population in memory by pressing the “Apply to Rollup” button.   

VERY IMPORTANT: The “Quick Recalculate” button does not save edits to 
memory. Use the “Apply to Rollup” button to save edits before leaving this 
screen or moving to a new population.  

Now that the AHA results have been reviewed, it is time to SAVE the work. 

Step 5: The most important step. SAVE population data. 
From the menu bar go to the File > Save and a dialog screen will open with save 
options (Figure 41).   

 
 
Figure 41.  File save options. 

“Quick Save” is what will be used in most cases.  This will simply save the data 
and any changes made.  “Advanced Save” is used if the user wants to save *.aha 
files, or save a user-defined strategy, overwriting an existing strategy in the 
dataset.  This will be discussed in more detail the next section describing 
advanced features of the application. 

On clicking “Quick Save” a traditional Windows “Save As” dialog will open 
(Figure 42). 

 
Figure 42.  The Windows “Save As” dialog screen to save a *.rol file. 

Columbia River Hatchery Reform Project 
Final Systemwide Report – Appendix D 
User Guide  Page 74 



  
 

Choose the location of the file to save.  Click “Save” and after a period of time (5 
– 60 seconds depending on the number of populations), a message will pop up 
asking the user to complete the save (Figure 43). 

 
 
Figure 43.  Confirmation message to complete the *.rol save. 

Congratulations!  A rollup file that can be used in a later AHA session or 
uploaded to the Hatchery Reform website has been successfully loaded/edited 
and saved. 

Finally, before closing the AHA application, the AHA application (Function Key 
- F12 opens the “Save As” dialog within Excel) should be saved to retain the 
global pattern and stray matrix data.  This information is saved with the AHA 
application and not the just saved *.rol file. Saving the AHA application means 
the next time the application is opened, only the *.rol file will need to be loaded 
because the global data are already stored with the application (Figure 44). 

 
Figure 44.  The Load Files dialog screen with stray matrix and pattern data loaded from a previous AHA session. 
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2.2.5 ADVANCED Features of the AHA Application 
In this section, more details about the topics covered in the quick start will be 
discussed and other important features of the AHA program will be described. 

The AHA menu bar 
AHA contains several different views, all of which are accessed from the 
navigation menu bar at the top of the screen. Note that the menu bar appears 
under the “Add-Ins” Ribbon in Excel 2007.   

Zoom controls for adjusting the viewing area 
To adjust the size of the viewing area in any screen, use the Ctrl + “[“ {left 
bracket} to reduce zoom value (zoom out), or Ctrl + “]“ {right bracket} to 
increase zoom value (zoom in).  To zoom to 100 percent, use the key 
combination Ctrl + Shift + “O”. 

Loading a Dataset 
This is always the first step when running AHA.  Population files (*.aha) are 
single-population data files (as generated from the single-population AHA tool), 
while *.rol files contain multiple population data files. A *.rol file can contain up 
to 450 distinct populations. These files are organized by species (Chinook, coho, 
steelhead, sockeye, and chum).  

The rollup application requires loading the population data contained in these 
files into memory before beginning to use the analysis tools. If the application 
Excel file (Function key F12 opens the Save As… dialog within Excel) is saved 
during an active AHA session, it may appear that data is still loaded from the last 
AHA session.  However, the data is not saved in memory and functions within 
AHA will not be available to the user.  The reason for this is that the AHA 
application stores population data in memory during a session, rather than 
through cells and formulas on worksheets.   

Therefore, it is very important to use AHA similarly to any other application:  
Open the data files (*.rol or *.aha) when beginning an AHA session, and even 
more important—Save the data files (*.rol or *.aha) before closing an AHA 
session.    

From the File menu, choose “Open” to locate the data files (Figure 45).  



  
 

 

Figure 45.  File > Open:  Load Data Files menu 

The first frame at the top of Figure 45 specifies the filename of the *.rol (or 
*.aha) file to load.  This is the population data that AHA stores in memory and 
must be saved (File > Save from the AHA menu bar) before closing AHA to 
preserve changes made in a session.   

Observe the other frames in Figure 45 labeled “Stray Matrix Loaded” and 
“Pattern Data Loaded”.  These refer to Global data assumptions.  If Global data 
was loaded into a saved version of the application in an earlier session, the data 
will remain loaded for later use.  Loading and management of Stray Matrix and 
pattern data will be discussed in more detail later. 

Click the “Browse” button within the frame to select the file from a traditional 
file explorer dialog as shown in Figure 46. 
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Figure 46.  Data directory with *.rol file highlighted. 

Select the file type to show the *.rol or *.aha files and then click on “Open”.  
Only one *.rol file can be loaded into the application at a given time. Multiple 
*.aha files representing different populations can be loaded into the rollup at the 
same time; however, these population datasets must all have the same scenarios 
or they will not load. 

The Excel status bar at the lower left is programmed to provide update messages 
during loading of data files.  Depending on the number of populations in the data 
files and the speed of the computer’s CPU, these could take up to a minute to 
load (longer in Excel 2007).  The application is reading the population list, 
distributing hatchery strays among populations, and calculating model outputs 
during this time.  Once the files are loaded, charts will appear in the Landing 
Page data window panes, as shown in Figure 47. 
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Figure 47.  The AHA Landing Page with population data summary. 

Loading AHA files 
AHA also has the ability to load and save *.aha files created from the previous 
generation of the AHA program.  However, the Hatchery Reform website does 
not contain *.aha files.  This feature is useful if the user wants to examine 
assumptions created using the previous versions of AHA.  Files loaded in as 
*.aha files can be saved out as *.rol files for combining with other *.rol datasets 
or upload to the Hatchery Reform website.  Saving files will be discussed in 
more detail later. 

To open *.aha files, go to File > Open>Browse, and pick *.aha from the file type 
dropdown menu.  

Reloading a Dataset 
Clicking Open during an AHA session (data loaded into memory) will bring up a 
different form asking the user to either start over with a new dataset (dumps data 
in memory and you will be prompted to load in a new datasets) or to add 
population data to the dataset in memory (Figure 48).  The ability to add 
populations to the dataset is to allow the user to bring in new populations.  An 
error will result if a population already exists in the dataset in memory. 
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Figure 48.  Dataset reload/add files options. 

Welcome Screen/Landing Page - Summary Charts 
The Welcome screen shows summary bar charts for all populations for a variety 
of model outputs. Information shown in the charts can be changed using the 
drop-downs above each chart. The green portion of the natural escapement charts 
represent the number of natural-origin adults in the escapement, the yellow 
portion shows the number of integrated hatchery adults in the escapement, and 
the red section displays the number of segregated hatchery-origin adults in the 
escapement.  

Filtering a Dataset by ESU or Region 
By default, all populations are included in the charts.  If desired, populations can 
be filtered by ESU, Province/Region/Subbasin, or by Species from the landing 
Page (Figure 49).  Select the filter using one of three radio buttons to the left and 
then select the desired filter values in the dropdown menu(s).  Finally, click the 
“Apply Filter” button to run the filters.  This will roll up the populations by the 
criteria you specified.  The bar charts on the Welcome screen and Strategy screen 
will only show information for the filtered populations.  Hatchery strays from all 
loaded populations are still included in the analysis.  In other words, the effects 
of straying are not excluded by the filters. To remove the filter select “All” from 
the filter options and click “Apply Filter.” 

 

Figure 49.  Filtering populations in AHA. 

In addition to the bar charts, the Welcome screen shows scatter plots for each 
population in the rollup. The top chart shows population Proportionate Natural 
Influence (PNI) versus proportion of hatchery-origin spawners in the total 
spawning population (pHOS).  The bottom chart shows population productivity 
(including fitness loss and harvest rates) versus population natural spawning 
abundance.  These charts can also be filtered by population designation (Primary, 
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Contributing, and Stabilizing) or by population type (Segregated hatchery, 
Integrated natural and hatchery, and None [natural]) using the check boxes to the 
right (Figure 50).  To toggle between population designation and population type 
filters, click the “V” button above the checkboxes.  The charts will update 
instantly upon toggling of the checkbox values.  These filters do not affect the 
bar charts or the population list in the Strategy page.   

 

 

 

 

 

 

Figure 50.  Scatter plots filtering options. 

The filtering features can be accessed from any page view by choosing Strategy 
> Filter Populations… from the menu bar. 

Global Page (Main Screen) - Setting Global Assumptions and Viewing Output 
By clicking on Rollup Views > Go to Global Page… in the menu bar, AHA will 
take the user to the Global Page.  This screen is to view and manage global 
pattern data for hydro, harvest and habitat assumptions and the results of the 
AHA analysis for the specified species and region across five different 
management strategies (Figure 51).  Edits made to a pattern from this screen or 
others are automatically saved into memory.   

 

Figure 51.  Main screen and global pattern assumptions. 
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The tool components shown on the Main screen (Figure 51) include the 
following items: 

Output Summaries.  There are four bar charts and two scatter plots on this page, 
the four bar charts are Escapement (NOS or NOS & HOS), Harvest Distribution 
(either NOS or HOS), Hatchery Surplus, and Smolt Release.  Each of these charts 
displays the results by alternative.  The two scatter plots in the lower right hand 
of the Main page show Viability and Hatchery Influence on Natural Spawning 
(Figure 52). Populations shown in all these charts are affected by filters set from 
the Welcome/Landing page previously described. 

 

Figure 52.  Scatter plots of population viability and hatchery influence.  

There are two ways to identify points in Viability and Hatchery Influence scatter 
plots: 

a. Click on a point of interest in either scatter plot.  The corresponding 
population and scenario will appear at the top of the page in the filter 
drop-downs. 

b. Use the dropdown menu to find the population of interest (Figure 53). 
The red markers will highlight the corresponding population points in the 
graphs below.  There are two markers for each population—one to 
indicate the “Current” strategy and the second to indicate the strategy 
shown in the Strategy dropdown menu. 
 

 

Figure 53.  Dropdown menu options to find a data point of interest in the scatter plots by strategy and/or 
population  
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Filtering the Scatter Plots by Strategy or Population.  The data in these plots 
can be filtered by strategy or by individual population.  This will reduce the 
clutter and focus on plotted values for a single population across strategies (to 
compare among strategies) or for multiple populations for a particular strategy 
(to compare current against a strategy for multiple populations).  First select the 
appropriate radio button at the upper right-hand corner of the active window.  
Second select either a strategy or population from the dropdown menu.  To return 
to the original view select “ALL” in the dropdown menu.   

Review Global Assumptions and Pattern Assignments 
Setting Global Variables.  Strategies include assumptions for global variables 
(Figure 54). These variables may either be specific to a particular population or 
to multiple populations of a similar species or race. Global variables (also called 
patterns) are for mainstem, estuary, and ocean survival (Hydro, Harvest, and 
Habitat). Clicking on the hyperlinks at the top of each list (Hydro Pattern, 
Harvest Pattern, or Habitat Pattern) will take the user to the corresponding 
pattern assumptions that can be edited for each population loaded in the *.rol file.  
AHA then allows the user to define/edit the patterns which affect the individual 
populations (this will take the user to a new screen). 

 

Figure 54.  Global Pattern settings are shown for six strategies. 

Hatchery variables are shown on the Strategy Page, accessible by the link at 
right. 

A list of patterns we are using in AHA is shown in Figure 55, listed by Strategy 
(Strategies are analogous to scenarios from the single-population AHA program).  
Pattern settings shown here were saved in the *.rol file, and they reference the 
patterns just loaded into AHA from the Hatchery Reform web site. 
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Figure 55.  Setting global variables for a particular “H” and strategy.  Pre-defined patterns may be selected for all 
populations by using the drop-down menu associated with each strategy and “H” (Hydro, Harvest, and Habitat). 

Pattern editing will be discussed in detail later, but for now click on each of the 
hyperlinks to get an idea of the information contained in patterns. 

To change pattern assignments for a given strategy, click on one of the pattern 
cells (Figure 55).  A dropdown menu arrow will appear to the right.  Clicking on 
this arrow will list the patterns currently available under the corresponding ‘H’.  
These are the patterns just downloaded from the Hatchery Reform website.  
Empty drop-downs (“##”) use assumptions in the AHA Rollup dataset. 

Pattern files can be saved from one instance of the AHA and loaded into another.  
This is important for sharing datasets between users.  Alternatively, the entire 
AHA application may be sent along with the population datasets. 

There is one big ‘H’ that has not been addressed yet: hatcheries.  As can be seen, 
hatcheries are not listed under the global variables here, instead there is a link to 
the Hatchery Assumptions (a.k.a. the Strategy Page); that’s where we will go 
next. 

Strategy Page – Defining Individual Population Characteristics 
The Strategy Page is one of the locations where individual population level 
variables can be modified; many of the hatchery assumptions are set here (Figure 
56).     
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Figure 56.  The AHA Strategy Builder screen. Model results and edits to population inputs can be made through 
this screen for a specific strategy. 

The Strategy Page may be reached from the Global Page as previously 
illustrated, but access will probably most often be from the menu bar. The tool 
components shown on this page include population inputs, managing strategies, 
managing strays, and managing populations. 

Input Population Parameters 
The Strategy page can be used to set the variables listed in Table 7 for a 
particular population. 

Table 7.  User Defined Population Level Variables 

Capacity Fitness Offset Terminal Harvest rates on HOR 
Productivity Broodstock-Local Terminal Harvest rates on NOR 
Program Type Broodstock-Import % HOR to Hatchery 
Program Purpose Broodstock-Export Weir Factor 
pNOB Goal HOR Rel. Reprod Success Hatchery Recruits/Spawner 

 

To change a variable, click in the text box under the “New” heading and type in a 
value. Next change the focus of the sheet by clicking somewhere else on the 
page.  After making edits to a population the user must click on the “Redistribute 
Strays” in order to see the effects of the edit on other populations. 
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To change the population focus click on the row of the population and then click 
“Go To” to jump to the population. A user can also navigate through the 
populations by using the up and down arrows next to the “Go To” button. Edits 
made to a population are saved in memory.  

Creating Strategies 
Users can use strategies defined in the *.rol file, or create their own strategies on 
the strategy page, by choosing different scenario settings between populations 
under a user-defined strategy.  This strategy exists outside of the traditional “6-
pack” of AHA scenarios.  It is a virtual strategy, that is not defined as one of the 
standard strategies (NEPA, HSRG, etc.) until it is saved under “Advanced Save” 
discussed in the next section. 

Selecting a Strategy to Edit.  Alternate management strategies can be selected 
by using the drop-down menu at the top. Also, combinations of different 
strategies can be selected by clicking on the strategy cell to the right of the 
population name and then selecting a new strategy.  

Click on the “Redistribute Strays” to see the effects of edits on other populations. 

WARNING:  By changing strategies for individual populations (drop-down to 
the right of the population), the user automatically enters the “New Strategy” 
mode (Figure 57).  The font color for the population strategies will change from 
gray to black.  A new strategy which is comprised of assumptions from different 
strategies is now being created.   

 

 

Figure 57.  Changing the Scenario value for a single population toggles the user-defined strategy feature. 

Hatchery Origin Spawners.  To view the identity and number of hatchery-
origin natural spawners from outside populations and from this population 
(internal strays), click on the cell of the recipient population for the “Hatchery 
Origin Spawners” column.  A comment box displaying this information will open 
near the upper right-hand corner of the active window. 

Chart views for a Population.  In the upper right-hand corner of the screen, the 
Strategy Builder shows the change in viability and hatchery influence on natural 
spawning for a specific strategy compared to the current situation.  The strategy, 
the estimated hatchery return, the natural escapement, and the harvest for the 
current condition are also shown. Last, a pie chart for natural populations 
indicates the number of natural-origin and hatchery-origin spawners in the 
natural escapement.  

Copying Strategies 
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The user may wish to use a current or working strategy as a baseline for a new 
working strategy in AHA.  To do this, go to the menu bar:  Strategy > Copy.  
The Copy Strategy screen shown in Figure 58 will appear. 

 
Figure 58.  The Copy Strategy screen. 

From the dropdown menu, the user simply picks the strategy in the dataset that 
he/she wants to copy and use as the baseline for other strategies.  Then check the 
boxes to be copied over.   

WARNING: Proceeding this way will overwrite the data in those strategies.  

Also, note that all the data associated with the population will be copied, but the 
IDs and names of the strategy will not change. 

Renaming Strategies 
Renaming strategies is done through a separate menu, which opens through the 
menu bar:  Strategy > Rename.  Here strategies can be given temporary names, 
for the purpose of data reporting (Figure 59).  The names given to strategies here 
are not applied to datasets on upload to the Hatchery Reform website. 

 

Figure 59.  Renaming a strategy in an AHA dataset. 
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Cloning a Population 
Cloning a population is the preferred method to add a population to an existing 
AHA dataset.  This ensures the new population has all the necessary parameters 
and the user can select a population with parameters that are most similar to the 
new population.  For best results, cloning a population should be done from the 
Strategy Page.  But, it can be done from any view in AHA.  Go to Population > 
Clone Selected Population in the menu bar.  A new population ID and name can 
be assigned here (Figure 60).  Make sure that the population ID or name does not 
already exist in the population list (Strays > Population List).  After creating the 
new population the user will need to go to the stray matrix and add straying 
assumptions if applicable for the new population (see Stray Matrix). 

 
 

Figure 60.  Cloning a population in an AHA dataset. 
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Deleting a Population 
Population not used in the analysis can be deleted from the dataset. To delete a 
population go to Population > Delete Selected Population.  Again, this can be 
done from any view in AHA, but it is advised to do this from the strategy page as 
it provides a list of all populations in the dataset.  A message confirming whether 
the user really wants to do this will pop up (Figure 61).   

 
Figure 61.  Confirmation message before deleting a population from the AHA dataset. 

WARNING: This cannot be undone.  Make sure that the dataset is backed up.  

Example: Using the Strategy Page 
In the Strategy Page example shown in Figure 62, a dataset that “rolls up” the 
Chinook populations in the Columbia River was loaded into AHA.  A table of 
population data reads on the lower half of the screen.  The scrollbar can be used 
to view columns in the table hidden off the current view. 
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Figure 62.  Strategy Page with Chinook dataset loaded. 

Assume for the moment that the user is interested in managing fish straying into 
the Big Creek Chinook population.  A table of values appears in the lower-right 
quadrant of the screen.  Under the column labeled Hatchery-origin Spawners, 
there is a column of values in commented cells. The comments are hidden until 
one of the cells in Figure 62 is clicked.  Click the cell that corresponds to 
Columbia Estuary Big Creek Fall Chinook and the comment is displayed in the 
upper-right quadrant of the screen (Figure 63). 
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Figure 63.  Chinook dataset with Stray information shown 

From the information contained in the comment box, it can be seen that there are 
six populations straying into the natural Big Creek Fall Chinook population.  A 
total of 943 fish straying into this population appear to originate from the Big 
Creek Fall Chinook hatchery.  That population is shown directly above the 
natural Big Creek Fall Chinook population. 

There are several ways to navigate between populations.  By clicking on the 
arrow keys to go up or down the list, the user can navigate to a population 
anywhere on the population row.  Highlight the row and click the “GoTo” button 
to jump to that population, or use the keyboard shortcuts:   

 Control + {Page Up} to go up one in the list, 

 Control + {Page Down} to go down one in the list. 

After selecting the Big Creek Fall Chinook hatchery, edits can be made to this 
population that may affect the number of strays to the previously reviewed 
natural population.  Specifically, changing the program size by editing 
broodstock abundance (smolt release is calculated from broodstock and in-
hatchery survival inputs), changing terminal harvest, changing percent HOR 
recovered at the hatchery, etc. To accept edits made to a program, click anywhere 
outside of the cell. 

Notice that the gray box to the left of the orange box is the Current condition.  
This value may also change to the new value depending on what was selected for 
the Strategy dropdown menu.  Figure 63 shows the Current condition strategy 
selected, changing this to a different strategy will keep the first column the 
Current condition and the New column will be the strategy edits. 

The last step to evaluate the effect of edits is to click “Redistribute Strays”.  Once 
the calculation is finished, the results of any edits to the hatchery program on the 
number of strays to the natural population of Fall Chinook in Big Creek can be 
seen. 
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Note that only the input cells shown at the top of Figure 63 under “New” can be 
edited.  The values shown to the immediate right of each population are results 
and input values to the far right cannot be edited from this screen (go to the 
Population Screen to edit these values). 

 AHA Population Page – Viewing/Editing Assumptions Across all Strategies 
The Single population AHA viewer is nearly identical to the previous generation 
of AHA, the functions of which have been integrated into this version with a few 
minor modifications.   

Individual management strategies can be compared for a single population by 
going to the Population Screen.  Navigation to the single-population view from 
the menu bar can be from either the Rollup Views menu item or the Population 
menu item (Figure 64).   

Or

 

Figure 64.  Navigation pathways to the AHA single population view. 

All input cells on the Population screen are yellow and calculated cells are in 
other colors (Figure 65).  Non-input cells are protected to prevent inadvertent 
modification of formulas.  

To update the calculated cells with the new inputs, click the “Apply & 
Recalculate” button at the top of the screen. 
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Figure 65.  The AHA Population screen. This screen shows the inputs and outputs for a specific population for all 
strategies. 

Population Page layout 
There are two levels of input: 1) a basic operating level and 2) an advanced, or 
detailed, level.  Most users will be operating at the basic level and that is shown 
on the Population page.  Additional parameters can be edited on these other 
pages specific to the hatchery program, natural population and fitness 
interactions.  Changing these parameters should be approached cautiously.  

The Population page is intended to be a self-contained “one-page” summary of 
the inputs and outputs for six strategies for a single population.  Each strategy 
section has two columns in the spreadsheet.  The columns continue vertically 
through both the input and output panels.  

More information for a particular population is available by going to the menu 
bar item under Population to access input screens for the natural component, 
hatchery component and fitness (Figure 66). 
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Figure 66.  Navigating to additional input screens for a population.  

• Natural Component – Contains the NOR survival data used by the 
application to compute the abundance of natural-origin fish and the 
make-up of the composite hatchery/natural population in future 
generations.  

• Hatchery Component – Contains hatchery program inputs and HOR 
relative survival in nature. This information is used by the application to 
compute the in-hatchery survival and relative survival of hatchery fish in 
nature. 

• Fitness – Contains fitness input parameters and equations used to 
calculate fitness loss for the composite population.  These inputs cannot 
be edited in the standard version of AHA. 

Inputs 
The input panel on the Population page is divided horizontally into four sections 
corresponding to each of the four H’s (Figure 65). Information about the 
population is shown in the upper left hand corner.   

Habitat  This section describes the natural environment.  In many cases, the 
inputs to this section come from an analysis of habitat condition. 

Productivity and Capacity:  Productivity and capacity are parameters of a 
Beverton-Holt production function.  Productivity is the density independent 
survival rate of the species in the environment measured as return/spawner over 
the entire life history.  This is the maximum possible survival without 
competition or density effects.  Capacity is the maximum number of individuals 
that could be supported by the habitat.  This is the asymptote of the production 
function.  These inputs are for the population over the entire life history and can 
come from EDT or be derived independently. 

Smolt Productivity and Capacity: These are calculated values based on the life 
cycle values entered above.  Smolt productivity and capacity removes the effect 
of out of subbasin conditions.  Productivity is smolts per spawner and capacity is 
the subbasin habitat smolt capacity. 
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Minimum NOR Escapement:  The minimum natural-origin escapement is used if 
there is an escapement goal established for the population.  In cases where there 
is not a minimum escapement goal, this parameter is set to a value of 1-- it 
should not be left blank.   

Percent Kelts:  For steelhead, the proportion of repeat spawners (kelts) can be 
specified.  For other species, this parameter is left blank  

Hydro  This section could also be labeled “Out-of-Subbasin Effects”.  This is 
where a specific survival rate through the hydroelectric system is supplied as well 
as the Smolt to Adult Return rate (SAR).  Hydro survival can be an estimate from 
a fish passage model such as SIMPASS or CRiSP.  SAR is the survival of smolts 
leaving the subbasin divided by the resulting adults back to the mouth of the 
subbasin before harvest. 

SAR is divided into juvenile passage in the mainstem, ocean survival, and adult 
passage survival in the mainstem. 

Vary? (Y/N):  This factor accounts for a measure of environmental variability.  
Random variability is attached to the marine component of the SAR input based 
on published patterns of variation in ocean survival conditions.   

Adjusted Productivity/Capacity:  These are calculated from the baseline 
production factors and the information under the Hydro section.  So that 
conditions outside the subbasin can be manipulated in AHA, the spreadsheet 
recalculates baseline productivity and capacity to reflect a change in conditions 
outside the subbasin relative to what was used for the baseline calculation of 
productivity and capacity.   For example, an increase in passage survival 
reflecting a specific change in the operations of the dams results in an increase in 
the overall productivity and capacity of the population9.  This becomes clearer by 
spending a few minutes spent changing conditions in the Hydro section and 
seeing how it changes the Adjusted Productivity and Capacity in the Habitat 
section. 

Harvest.  Harvest inputs are obtained from analysis of coded wire tags or from 
harvest analysis models.  Separate harvest inputs can be provided for natural-
origin fish (NORs) and hatchery origin fish (HORs). 

Harvest Rates:  Harvest rate is the fishing mortality imposed at a specific 
location.  Location is treated very generally: 1) marine, 2) Lower Columbia 
River, 3) Upper Columbia River, and 4) terminal area upstream of McNary Dam 
and within the subbasin.  Separate rates can be provided for natural- (NORs) and 
hatchery- origin (HORs) fish to account for differential harvest of natural and 
hatchery adults. 

Total Exploitation Rate:  Exploitation rate is the total mortality imposed on fish 
by harvest in terms of adult equivalents at spawning.  This is a calculated field in 
AHA that is based on the harvest rates provided. 

Hatchery.  Because of the lack of independent hatchery models similar to those 
available for the other H’s, AHA devotes more attention to the details of hatchery 

                                                 
9 Note that capacity is related to productivity such that an increase in productivity (density-independent 
survival) increases capacity as well. 
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operations.  Indeed, many applications of AHA involve questions of how 
hatcheries could be managed to achieve management goals in the context of the 
other Hs.   

Broodstock composition:  The goals for pNOB and pHOS refer to the intended 
proportion of hatchery broodstock comprised of natural-origin fish in each 
generation (pNOB) and the proportion of the natural spawning population 
comprised of hatchery- origin returns (pHOS).  Note that actual pHOS is 
calculated based on harvest, number of hatchery fish spawning in nature, and the 
size of natural population. 

PNI/pHOS Realized:  Regardless of the intent or goal of the program, the actual 
values for PNI and pHOS will depend on the size of the hatchery program and 
the return of natural-origin fish to the system.  These calculated cells provide the 
resulting PNI and pHOS for the population and strategy of interest.   

Broodstock by Source:  This is the number of adult fish that are spawned in the 
hatchery (males and females).  Broodstock imported from outside the system can 
also be indicated as number of adults imported. The total broodstock is the sum 
of local and imported fish.  

Program Release:  The total number of fish released is a calculated field based on 
number of broodstock, eggs/female, percent females, egg to fry, and fry to 
release survival rates in the hatchery.  The factors that go into computing the 
smolt release are found on the Hatchery Component  page. 

Brood Exported (from HOR surplus):  This refers to the realized and target 
broodstock export values. 

Strays:   The influx of hatchery fish from other populations is included in the 
AHA calculations.  The number shown here represents the number of strays from 
other populations entering the subbasin.  The source of these strays can be 
reviewed from the Strategy page described previously. 

Destination for HOR returns:  This refers to the percentage of hatchery-origin 
fish (HORs) recovered at the hatchery.  The number of fish straying to the natural 
population is calculated as 1-the proportion entering the hatchery. 

Recruits/Spawner:  This factor for hatchery fish is analogous to the productivity 
value entered above for the natural population.  It is the survival rate from 
spawner to adult.  It is usually computed from coded wire tag data or other 
hatchery information. 

Fitness:  This is simply a toggle to apply or ignore the fitness calculations in the 
analysis.  

Patterns:  While making edits on the population page, changes to one or more 
working patterns may need to be preserved.  To apply changes to patterns for a 
single population using values modified on the Population Page, choose the 
desired pattern to update by clicking on the pattern name and choosing it from 
the dropdown list.  Then type a “Y” in the cell next to the chosen name.  Once 
the pattern choices have been made, click the “Update” button at the far left of 
the view. Note: only type “Y” to modify patterns under one of the scenario 
columns (Figure 67). 

 



  
 

 

Figure 67.  Modifying pattern assignments from the AHA single population screen. 

Output 
The results of the AHA computations are summarized in figures on the lower 
three panels of the Population sheet.  Generation by generation results for each 
scenario can be found in the Scenario pages. 

Realized Spawning Composition  This chart (Figure 68) plots the realized 
proportion of hatchery fish in the natural population (pHOS) against the 
proportion of natural-origin broodstock in the hatchery broodstock (pNOB).  
These numbers are calculated in the input section and were discussed above.  
Note that each scenario has a distinctive marker.  The marker is shown in the 
hatchery input section between the pNOB and pHOS labels.  The results of each 
scenario are plotted on the chart so that the change in the spawning composition 
across scenarios can be examined. 

 
Figure 68.  AHA output chart comparing the proportion of hatchery origin fish in the naturally spawning 
component (pHOS) and the proportion of natural origin fish in the hatchery broodstock (pNOB).  PNI is the 
proportionate natural influence in the program and is represented by lines through the chart. 

This chart also shows the Proportionate Natural Influence (PNI).  PNI is a 
function of the proportion of natural spawners that are of hatchery-origin (pHOS) 
and the proportion of the hatchery broodstock that are of natural-origin.  PNI 
increases with decreasing pHOS and increasing pNOB. 

The chart has a color pattern to indicate the degree of hatchery and natural 
influence on the population.  Increasing levels of natural-origin fish in the 
hatchery broodstock (pNOB) trend toward the green areas of the chart 
representing less hatchery influence, while increasing levels of hatchery origin 
fish on the spawning ground tend toward the pink areas representing more 
hatchery influence.   

Adult Return Composition.  This chart (Figure 69) provides for each scenario 
the number and composition of fish produced by the natural population and 
hatchery program for marine, upper mainstem, lower mainstem, and terminal 
harvest. It also shows the number and composition of hatchery and natural 
spawners in columns labeled “Hatchery” and “Habitat,” respectively.  
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Composition of the fish in each category is indicated by the color coding 
explained in the caption to Figure 60.  

 
Figure 69.  Summary of AHA results comparing the number of adult fish in the spawning population and in 
harvest.  The contribution of hatchery origin fish (HOS) in each area is shown in pink, and the contribution of 
natural-origin fish (pNOB) are shown in green. “Candy-stripe” indicates hatchery fish returning in excess to 
spawning needs while “khaki” indicates return of hatchery-origin fish that have been selected at least one 
generation in the natural environment. 

Editing Patterns (Hydro, Harvest, Habitat) 
Patterns provide a standard set of assumptions that can be applied across 
populations.  Some of these variables appear on the strategy and population 
pages as well.  Population settings under hydro, harvest, and habitat patterns are 
viewed and edited by going to the corresponding pattern under the “Patterns” 
menu bar item (Figure 70).   

 
 
Figure 70.  Pattern menu items in AHA. 

Patterns downloaded from the Hatchery Reform web site can be chosen here for 
editing.  Each pattern editor has its own view, as shown below in Figure 71. 
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Figure 71.  Viewer/Editors for Hydro, Harvest, and Habitat patterns. 

The interface in this view works like a standard database program in that changes 
must be APPLIED in order to take effect.   In other words, click the “Remember 
H… Pattern in the upper-right of the view to apply changes.   

To edit pattern values, simply type into yellow cells.  Solid red cells will display 
for populations where no pattern data is present.  It is recommended that the 
user makes sure that data under the “#baseline#” pattern is complete.  If no 
baseline pattern data exists, the lack of data could cause some inputs to go to 
zero.  Type a new name in the dropdown menu and click “Remember H… 
Pattern” to create a new pattern.  To delete a pattern, pick “Delete Pattern” from 
the Patterns menu. 

Data Tables 
The population data shown on the Landing Page can also be viewed in a tabular 
form by choosing the menu bar item Rollup Views > Data Tables (Figure 72).  
This is provided to allow a more detailed evaluation of results across scenarios, 
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Figure 72.  Tabulated data from the population rollup. 

Stray Matrix 
The stray matrix can be viewed and edited by choosing the menu bar option 
Strays > Stray matrix (Figure 73).  Type changes to values in yellow cells, and 
make sure that you are not creating a duplicate pair of donor/recipient population 
ID’s.  After making revisions on the stray matrix page, be sure to click the 
“Reload Stray matrix” button to apply the changes. 

 
Figure 73.  The stray matrix. 
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To add a population name that does not appear in the stray matrix, go to the 
menu bar: Strays > Go to population list and append the list with the population 
IDs and names to be added. 

Strays Reporting 
A summary of straying results by population and strategy can be produced in 
AHA. Go to the menu bar and choose Strays > Strays report.  Type the ID 
number of the strategy (number to the right of the strategy name in the grayed 
section) in the yellow box (upper left) shown in Figure 74 for which you want to 
generate a report, and click “Go”.   

 
 
Figure 74.  Stray reporting by ESU 

2.2.6 Ending the AHA Session 
To end the AHA session, the population dataset must first be saved.  The AHA 
application must also be saved if it is desired to preserve the pattern and stray 
matrix files that were loaded earlier. 

Saving an AHA Rollup Dataset 
The Save button is accessible from the menu bar at the top. Go to File > Save. 

The simplest option is the “Quick Save” feature. Clicking this feature will result 
in a request to select a directory and to name the file (Figure 75). 
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Figure 75.  Options for saving an AHA Rollup dataset. 

The “Advanced Save” allows the user to save the populations as individual 
population *.aha datasets or to save the dataset as a *.rol file with the option to 
revise a strategy label (Figure 76). 

 
Figure 76.  Save options for the “Advanced Save” feature. 

Both of these options will ask the user to identify a strategy and a strategy label 
to overwrite. The AHA Rollup will overwrite the selected strategy with the 
information shown on the Strategy Builder Screen. In other words, if the current 
strategy was selected, the program will overwrite the chosen strategy with the 
current conditions. This feature is used to copy a strategy to other strategies 
during the save process. 

It is recommended that most users employ the “Quick Save” feature unless they 
want to specifically overwrite a strategy.  Note that the Advanced Save is the 
only way to permanently reassign a strategy to different ID (Figure 77).   
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Figure 77.  A request to select a strategy to overwrite and the label for the Strategy under the “Advanced Save” 
option. 

The Strategy currently selected on the strategy page is the one that will be 
permanently saved.  Choose the name of the strategy to be overwritten from the 
dropdown menu.  Then if a different Name/ID for the strategy is desired, check 
the box “Label Strategy As…”, and choose a new Name/ID from the enabled 
dropdown menu. 

Exporting Patterns and Stray Matrix Data 
From the menu bar, choose File > Export Pattern Set and Stray Matrix Files.  
This will bring up the Save screen for patterns and stray matrix (Figure 78)  
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Figure 78.  The save/export pattern data menu 

Here the user can browse to the desired locations in which the pattern (*.hyd, 
*.hrv, *.hab), stray matrix (*.smx), and if desired, population data (*.rol) files 
will be saved.  AHA will allow any of these fields to be left blank, if saving only 
subset of these files is all that is needed. 

Saving an AHA Rollup Application 
When closing Excel, the program will prompt the user to save the AHA 
Application (Figure 79). This was added to ensure the user does not close without 
saving global variable information. This information is saved with the application 
and not the AHA dataset. Selecting Cancel will stop the procedure and will allow 
you to save the AHA Excel file using the standard save menu item in Excel. It 
does not matter which version of Excel is being used. 
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Figure 79.  Prompt to save AHA Rollup application when closing Excel.  If pattern and stray matrix data should be 
saved in the application, hit OK, then click the function key - F12 to save the AHA application as a new file 
containing pattern data. 

The standard Excel prompt to save the file after selecting OK may appear. There 
is no need save the file if no edits have been made to the global variables.  
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